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1 Introduction

Embedded Web Server RX (Remote eXtension), which will hereafter be
referred to as the embedded server, refers to the web server that is built into the
printing device. It allows you to verify the operating status of the device and
make settings related to security, network printing, E-mail transmission and
advanced networking.
With the embedded server, the administrator can remotely track paper and
toner usages per user and the status of optional equipment installed. The
embedded server also configures device settings, monitors jobs, and manages
document boxes and address books.

System Requirements
The embedded server operates in the following environment. Check the
following before use.

Protocols
• The TCP/IP protocol is installed on the PC.

• An IP address is assigned to the printing system.

Web Browser
• Microsoft Internet Explorer 7.0 or later (Microsoft Internet Explorer operates

on Microsoft Windows XP/ Vista/7, and Microsoft Windows Server
2003/2008.)

• Mozilla Firefox 3.5 or later

• Safari 4.0 or later (Safari operates on Apple Mac OS X 10.4 or later.)

Accessing the Embedded Server
Access the embedded server by entering the printing system's host name or IP
address in a web browser. Obtain the IP address from your network
administrator.

1 Open a web browser.

2 Enter the device's host name or IP address as the URL. For example,
http://192.168.10.1.

The embedded server's home page will be accessed and displayed. The home
page requests a User name and Password. For initial login, use the predefined
Admin as the User Name, and Admin as the Password. This is set up internally.
For successive logins use any login name or password set up later in the
embedded server. Refer to Advanced > Management > Authentication >
General on page 6-45.
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2 The Embedded Server
Home Page

The embedded server's home page allows you to select a category from the
navigation menu on the left to view and set values for that category, as well as
displaying information on the device, user, and consumables on the right, which
changes according to the selection in the navigation menu.

Login
To fully access the features of the embedded server pages, enter the User
Name and Password and click Login. Entering the predefined administrator
password allows the user to access all pages, including Document Box,
Address Book, and Settings on the navigation menu.
To access the embedded server pages, the users can be identified by choosing
one of network authentication, local authentication, and job accounting
authentication methods. For details, see Levels of Login on page 3-1.

Top Bar
At the top of the home page, you can perform the following:
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The Embedded Server Home Page

Home
To quickly return to this home page (top page) from any other server page,
click Home.

Select language
The embedded server supports multiple languages. To change the language
that the embedded server is displayed in, open the language drop down list
and select the appropriate language. If you attempt to view the embedded
server with a character set other than the language that is used on the
operation panel's display, some characters may be garbled.

Auto-refresh
To continuously update the embedded server's pages to the most recent
status, select the Auto-Refresh check box.

Refresh
Click this circular arrow icon to refresh the embedded server pages any time.

Navigation Menu
The navigation menu at the left of the home page divides the following functions
onto separate bars. By clicking each bar, you can jump to the desired page as
outlined below:
My Information

My Information is accessible only when you have logged in the embedded
server with a general user or administrator privilege, and user authentication
is enabled. This page summarizes the general settings to which access is
granted by the general user. This depends on the scope of the user's or
group's privileges. For example, if a user is allowed access to the document
box, he/she can add or delete documents in the document box shown in My
Information.

Device Information
This page includes this machine's various information that apply to the entire
machine, such as Device Defaults, Basic Networking as well as model,
optional equipment installed, firmware, network parameters, FAX
parameters, and information on the supported browsers.

Job Status
This page includes information on all device jobs including job status for
printing, scanning, storing, and scheduled as well as job log. After clicking on
Job Status, information is available in the following job status pages:
Printing Job Status, Sending Job Status, Storing Job Status
Displays details on each job. You can narrow details you need by pulling
down Type. Click Refresh above to update details. Click Cancel Job to
abort the job. To see details on each job on the log, click Number or Name
of the job.
Scheduled Jobs (when FAX is installed)
This page is populated with FAX jobs currently scheduled for transmission.
Click Refresh to update the list. Click Cancel Job to remove the FAX job
from the list to abort.
Printing Job Log, Sending Job Log, Storing Job Log
Displays logs to track jobs of each type. You can narrow details by pulling
down Type. Click Refresh at the right end of the Top Bar to update the list of
logs. To see details on each job on the log, click Number or Name of the job.
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The Embedded Server Home Page

Document Box
This page allows you to add, edit, or delete a document box, and delete
documents in a document box. Under Document Box, Custom Box, Fax
Box, Sub Address Box, and Polling Box are included. For more
information, see page 4-1.

Address Book
This page allows you to add, edit, or delete of a contact address or a group
of addresses. For more information, see page 5-1.

Settings
This page includes advanced settings that apply to the entire device,
including primarily advanced network settings and security settings. For
more information, see page 6-1.

Status Displays
The home page displays information on the status of the device, operation
panel usage, and consumables, to the right of the page. This page allows you to
quickly verify the device's current settings and statuses.
Device Status

Shows the operating status of the printer, scanner, and FAX.
Operation Panel Usage

Shows the user currently logged in the device from the operation panel and
its operating status. Note that settings made using the operation panel may
override those made using the embedded server.

Paper
Shows the size, type, maximum capacity, and the current supply by paper
source.

Toner
Shows the toner supply by color. The status of the waste toner box is also
given.

Optional Equipment Status
Shows the status of the optional devices, such as the amount of the
remaining staples and the punch waste.
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3 About Login

This section provides information to help the administrator manage domain and
local users. The administrator can set authentication that allows the predefined
users to access the embedded server pages and set administrator passwords.

Levels of Login
An administrator can configure the device to require a user login before it is
accessed in either of three different ways of authentication as described in this
section.
If you select local or network authentication, User Login must be turned on.
The default user name and password, or the local administrator account when
User Login is turned off, is Admin. Note that the embedded web server does not
provide administrative limitation against the access to itself.
Local Authentication

Users are registered in this device and one-to-one authentication is
performed between this printing system and a PC. A local account user
accesses the embedded server by entering User Name and Password and
selecting Local in the drop-down list (if shown) below the entries, followed by
clicking the Login button.
A user logged in with an administrator privilege can gain access to My
Information, Device Information, Job Status, Document Box, Address
Book, and Settings on the navigation menu.
A user logged in with a general user account cannot add or delete document
boxes, nor view the Address Book and Settings pages.
To add, delete or configure a locally authenticated user, refer to Basic >
Security > User Login on page 6-10.

Network Authentication
In the case where the device is configured for network authentication, the
device and the relevant PC's need to be under the management of a
Windows domain network. Enter the User Name and Password and select
the domain you want to login in the drop-down list.
Once you have logged in with an administrator privilege, you can access to
My Information, Device Information, Job Status, Document Box,
Address Book, and Settings on the navigation menu.
A user logged in with a general user account cannot add or delete document
boxes, nor view the Address Book and Settings pages.
To add, delete or configure a network authenticated user, refer to Advanced
> Management > Authentication > General on page 6-45.

Authentication Using Job Account ID
In the case where the device is configured for job accounting but not for User
Login, a user can be authenticated by his/her job account ID. Enter the job
account ID in Account Login and click Login.
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About Login

If a user is registered as an administrator on the User Login user list (Refer
to Basic > Security > User Login on page 6-10), he/she can select either
Account Login or Administrator Login.
For access using a job account ID, My Information, Device Information,
Job Status, Document Box, and Address Book are displayed in the
navigation menu.
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4 Document Box

This page is accessible when you have logged in using a general user or
administrator account. It allows you to add or delete a document box, as well as
deleting documents in a document box. A general user is not allowed to add or
delete a document box.
There are several types of document boxes, which vary depending on models:
Custom Box, FAX Box, Sub Address Box, and Polling Box as described
below. Note that FAX Box, Sub Address Box, and Polling Box are available
only if the device is equipped with a FAX kit.
The users with a general user account can delete the documents which were
created and added in their own document boxes.

Custom Box
The section below explains how to add, edit or delete custom boxes as well as
working with their contents.

Adding a New Custom Box

1 Click Custom Box under Document Box on the navigation menu.

2 Click Add. The New Box - Property page will open.

3 Make entries required to define the custom box, such as Number, Name, etc.

4 Click Submit.

Editing a Custom Box

1 Click Custom Box under Document Box on the navigation menu.

2 Select the custom box you want to edit by clicking on its Number or Box Name.
The documents contained in the custom box are displayed with its name, date
of creation, size, etc. You can choose List View or Thumbnail to view the box
contents.
Alternatively, you can open the list of the user boxes, directly enter the box
number in the Box # window and click Go to, or enter the box name in the Box
Name window and click the magnifying glass icon, to quickly search the custom
box.

3 Click Box Property. The Property page opens.

4 Make entries required to modify the custom box properties such as Number,
Name, etc.
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Document Box

5 Click Submit.

Working with a Custom Box
You can delete, move, copy, join, download, E-mail or print documents in the
custom box.
First select the document to apply any of the above actions by following the
steps below:

1 Click Document Box, then Custom Box which will open below on the
navigation menu.

2 Select the custom box you want to work with by clicking on its Number or Box
Name. If the box is password-protected, enter the password to proceed. The
documents contained in the custom box are displayed with its name, date of
creation, size, etc. You can choose List View or Thumbnail to view the box
contents.
Alternatively, you can open the list of the user boxes, directly enter the box
number in the Box # window and click Go to, or enter the box name in the Box
Name window and click the magnifying glass icon, to quickly search the custom
box.

3 In the custom box, select the check box next to the name of the document that
you want to apply the action. You can select multiple documents
simultaneously.

Deleting a Document

1 Select the document to delete as described above.

2 Click Delete.

Moving a Document from Box to Box

1 Select the document to move as described above.

2 Click Move. The Move Settings page opens. The files selected are shown in
Selected Files.

3 Select the box to move the document to in Destination. If the box is password-
protected, enter the password.

4 Click Move. The document is moved to the box.

Copying a Document to Box

1 Select the document to copy as described above.

2 Click Copy. The Copy Settings page opens. The files selected are shown in
Selected Files.
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Document Box

3 Select the box to store the copied document in Destination. If the box is
password-protected, enter the password.

4 Click Copy. The document is copied into the box.

Joining Documents in One

1 Select the documents to join as described above.

2 Click Join. The Join Settings page opens. The files selected are shown in
Selected Files.

3 If desired, change the order of the documents to be joined by clicking Top, Up,
Down, and Bottom. You can exclude a document from the Selected Files list
by clicking Delete.

4 Name the new document which the documents selected are joined in File
Name.

5 Click Join. The documents are joined in the new document.

Downloading a Document to PC

1 Select a document you want to download and store into your PC as described
above. You can download only one document at a time.

2 Click Download. The Download Settings page opens. The selected file is
shown in Selected Files.

3 Use the Color Selection drop-down list if you want to change the color of the
document after downloading. For example, you can download a color document
as a monochrome document when it is stored in PC.

4 Use the File Format drop-down list to choose the type of the document you
want to download.

5 Click Download to begin downloading. Enter the name and destination of the
document as you are prompted.

Note: If downloading is interrupted by the web browser's pop-up blocking,
perform the following:

• For example, on Internet Explorer 8, go to Tools > Pop-up Blocker > Turn
Off Pop-up Blocker to turn off pop-up blocking. Or, go to Pop-up Blocker
Settings and enter the print system's IP address in Allowed sites.

• If pop-up blocking is still engaged, on Internet Explorer 8, go to Tools >
Internet Options > Security > Custom level > Downloads > Automatic
prompting for file downloads and select Enable.

• If downloading won't complete, try to turn off SmartScreen Filter by browsing
to Safety > SmartScreen Filter > Turn Off SmartScreen Filter on Internet
Explorer 8.
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Document Box

Sending a Document to a Destination

1 Select a document you want to send as described above. You can send only
one document at a time.

2 Click Send. The Send Settings page opens. The selected file is shown in
Selected Files.

3 In Destination, select a destination from Address Book, E-mail, Folder, FAX
and i-FAX.
To select a destination, select Address Book to display the destinations
currently registered (depending on E-mail, Folders, FAX, i-FAX, or Groups).
Note, however, FAX is not displayed if the entry of new addresses is prohibited
in the device's system menu.
To delete a destination from Destinations, click Delete.

4 Use the Color Selection drop-down list if you want to change the color of the
document to send. For example, you can send a color document as a
monochrome document.

5 Name the document in File Name.

6 Enter the date of sending and job ID in Additional Information. These entries
are appended in the file name.

7 Use the File Format drop-down list to select the type of the document you want
to send.

8 Click Send. If you are prompted to confirm sending, in case Confirmation
Screen is activated on the device's operation panel, make confirmation. The
document is sent to the destination.

Printing a Document

1 Select the document(s) to print as described above.

2 Click Print. The Print Settings page opens. The files selected are shown in
Selected Files.

3 If desired, change the order of the documents to be printed by clicking Top, Up,
Down, and Bottom. You can exclude a document from the Selected Files list
by clicking Delete.

4 Enter the number of copies to print in Copies.

5 Use the Color Selection drop-down list if you want to change the color of the
document when it is printed.

6 In Functions, change settings for Duplex, EcoPrint, Toner Save Level as
desired.
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Document Box

7 Click Print. The document is printed.

Deleting a Custom Box

1 Click Custom Box under Document Box on the navigation menu. The Custom
Boxes page opens. Click All Boxes to show all custom boxes present in the
device, and click My Boxes to show only the custom boxes of your own.

2 Click Delete once. This will not delete any custom box yet, but this will let the
checkboxes (Select) appear to the left.

3 Select the custom box you want to delete by selecting the checkbox to the left.
You can select only one custom box to delete at a time.
You can enter the box name in the Box Name window and click the magnifying
glass icon to quickly search the custom box.

4 Click Delete.

FAX Box
The section below explains how to add, edit or delete FAX boxes as well as
working with their contents.

Adding a New FAX Box

1 Click Document Box > FAX Box in the navigation menu.

2 Click Add and enter descriptions for the FAX Box.

3 Click Submit.

Editing a FAX Box

1 Click FAX Box under Document Box on the navigation menu.

2 Select the FAX Box you want to edit by clicking on its Number or Box Name.
The documents contained in the FAX Box are displayed with its name, date of
creation, size, etc. You can choose List View or Thumbnail to view the box
contents.
Alternatively, you can directly enter the box number in the Box # window and
click Go to, or enter the box name in the Box Name window and click the
magnifying icon, to quickly search the FAX Box.

3 Click Box Property. The Property page will appear.

4 Make entries required to modify the FAX Box properties such as Number,
Name, etc.

5 Click Submit.
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Working with a FAX Box

1 Click FAX Box under Custom Box in the navigation menu.

2 Select the FAX Box you want to work with by clicking on its Number or Box
Name. If the box is password-protected, enter the password to proceed. The
documents contained in the FAX Box are displayed with its name, date of
creation, size, etc. You can choose List View or Thumbnail to view the box
contents.
Alternatively, you can directly enter the box number in the Box # window and
click Go to, or enter the box name in the Box Name window and click the
magnifying glass icon, to quickly search the FAX Box.

3 In the FAX Box, select the check box next to the name of the document that you
want to apply the action. You can select more than one document
simultaneously.

4 Select either of Delete, Download, and Print to apply to the document. To
perform any of these actions, follow the same procedure as described in
Working with a Custom Box on page 4-2.

Deleting a FAX Box

1 Click FAX Box under Document Box in the navigation menu. The FAX Boxes
page opens. Click All Boxes to show all custom boxes present in the device,
and click My Boxes to show only the custom boxes created under your
account.

2 Click Delete once. This will not delete any FAX Box yet but this will let check
boxes (Select) appear to the left.

3 Select the FAX Box you want to delete by selecting the check box to the left.
You can check only one custom box to delete at a time. You can enter the box
name in the Box Name window and click the magnifying glass icon to quickly
search the custom box.

4 Click Delete. If required, enter the password and click OK.

Sub Address Box
The section below explains how to add, edit or delete sub address boxes as well
as working with their contents.

Adding a New Sub Address Box

1 Click Document Box > Sub Address Box in the navigation menu.

2 Click Add and enter descriptions for the sub address box.

3 Click Submit.

Embedded Web Server RX 4-6



Document Box

Editing a Sub Address Box

1 Click Sub Address Box under Document Box on the navigation menu.

2 Select the Sub Address Box you want to edit by clicking on its Number or Box
Name. The documents contained in the Sub Address Box are displayed with its
name, date of creation, etc.
Alternatively, you can directly enter the box number in the Box # window and
click Go to, or enter the box name in the Box Name window and click the
magnifying icon, to quickly search the Sub Address Box.

3 Click Box Property. The Property page will appear.

4 Make entries required to modify the Sub Address Box properties such as
Number, Name, etc.

5 Click Submit.

Working with a Sub Address Box

1 Click Sub Address Box under Document Box in the navigation menu.

2 Select the Sub Address Box you want to work with by clicking on its Number or
Box Name. If the box is password-protected, enter the password to proceed.
The documents contained in the Sub Address Box are displayed with its name,
date of creation, etc.
Alternatively, you can directly enter the box number in the Box # window and
click Go to, or enter the box name in the Box Name window and click the
magnifying glass icon, to quickly search the Sub Address Box.

3 In the Sub Address Box, select the check box next to the name of the document
that you want to apply the action. You can select more than one document
simultaneously.

4 Select either Delete or Print to delete or print the documents, respectively. To
perform either of these actions, follow the same procedure as described in
Working with a Custom Box on page 4-2.

Deleting a Sub Address Box

1 Click Sub Address Box under Document Box in the navigation menu. The
Sub Address Boxes page opens. Click All Boxes to show all document boxes
present in the device, and click My Boxes to show only the document boxes
created under your account.

2 Click Delete once. This will not delete any Sub Address Box yet but this will let
check boxes (Select) appear to the left.

3 Select the Sub Address Box you want to delete by selecting the check box to
the left. You can check only one document box to delete at a time. You can
enter the box name in the Box Name window and click the magnifying glass
icon to quickly search the document box.

4-7 User Guide



Document Box

4 Click Delete. If required, enter the password and click OK.

Polling Box
This page allows you to print or delete documents in polling boxes. Also, you
can determine whether documents are automatically deleted or retained after
polling.

Polling Box Property
Polling Box Property determines after the document has been sent, whether
you want the document to be automatically deleted or to be retained
(overwritten).

1 Click Document Box, then Polling Box which opens below on the navigation
menu. The Polling Box page opens.

2 Click Box Property. The Polling Box - Property opens to select whether the
document which was sent is deleted, or overwritten and retained.

3 To configure the box so that documents are overwritten at updating, set
Overwrite Setting to On. To configure the box so that documents are
automatically deleted after transmission, set Delete after Transmit to On.

4 Click Submit.

Deleting Documents in Polling Box
To delete documents in a polling box, proceed as follows:

1 Click Document Box, then Polling Box which opens below on the navigation
menu. The Polling Box page opens. You can choose List View or Thumbnail
to view the box contents. To view details on a document in the polling box, click
its Name. The Property page opens and you can view the number of pages,
resolution, etc. You can also change the file name by clicking Change File
Name or preview by clicking Preview on this page.

2 Select the document(s) you want to delete by selecting the check box to the left.
You can select more than one check box to delete the documents
simultaneously.

3 Click Delete.

Printing Documents in Polling Box
To print documents in a polling box, proceed as follows:

1 Click Document Box, then Polling Box which opens below on the navigation
menu. The Polling Box page will appear. You can choose List View or
Thumbnail to view the box contents. To view details on a document in the
polling box, click its Name. The Property page will appear and you can view the
number of pages, resolution, etc. You can also change the file name by clicking
Change File Name or preview by clicking Preview on this page.
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2 Select the document(s) you want to print by checking the checkbox to the left.
You can select more than one checkbox to print the documents in succession.

3 Click Print. The Basic submenu will open.

4 You can immediately start to print the documents in the order shown in
Selected Files by clicking Print. If you want to change the order of printing,
highlight a document and press Top, Up, etc. If you want to omit a document
from the list, press Delete.

5 Press Print.
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This page is accessible when you have logged in the embedded server with an
administrator privilege, while network authentication or local authentication is
enabled.

Contacts
This section explains how to add, edit or delete contacts in the address book.
In the Addresses page, contacts and groups are listed together. Contacts are
identified by the 'single-person' icon and groups by the 'triple-person' icon. You
can filter the display for contacts or groups by choosing Contact or Group on
the Type drop-down list.

Adding a New Contact

1 Click Address Book in the navigation menu. The Addresses page appears.

2 Click Add Contact. The New Contact - Property page opens.

3 Enter the contact's Number, Name and E-mail.
You can also enter SMB and FTP access information for the contact. Specify
Host Name, Port Number, Path to the shared folder, Login User Name, and
Login Password for the contact. When the Test button is pressed, this machine
tries to connect to the SMB or FTP server.
If the FAX system is installed or i-FAX is activated in the system, you can
include a FAX number and/or i-FAX address.

4 Click Submit to complete. To cancel, click Back.

Editing a Contact
The steps below allow you to modify the number or name, e-mail address, SMB
and FTP information, FAX and i-FAX settings of a contact.

1 Click Address Book in the navigation menu. The Addresses page appears.

2 Select the contact you want to edit by clicking its Number or Name. The
Property page appears.
Alternatively, you can directly enter the address number in the Address #
window and click Go to, or enter the contact name in the Address Name
window and click the magnifying glass icon, to quickly search the contact.

3 Modify Number, Name, or E-mail of the contact. If the system is installed with a
FAX system or has i-FAX activated, you can modify these settings.
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4 Modify the settings for SMB and FTP accesses as desired. When the Test
button is pressed, this machine tries to connect to the SMB or FTP server.

5 Click Submit. To cancel, click Back.

Deleting a Contact

1 Click Address Book in the navigation menu. The Addresses page appears.

2 Select the contact(s) you want to delete by selecting the checkbox to the left.

If you want all contacts displayed on the page deleted, click Check All. To
deselect all, click None.

3 Click Delete.

Groups
This page allows you to add, edit or delete groups of contacts. In the
Addresses page, contacts and groups are listed together. Contacts are
identified by the 'single-person' icon and groups by the 'triple-person' icon. You
can filter the display for contacts or groups by choosing Contact or Group on
the Type drop-down list.

Adding a New Group

1 Click Address Book in the navigation menu. The Addresses page appears.

2 Click Add Group. The New Group - Property page opens.

3 Enter the group's Number, or leave it to the system to automatically assign a
number, and the group's Name.

4 Add contacts to the group by clicking the plus sign (+). The Addresses page
appears.

5 Select the contact to join in the group by selecting the Select checkbox to the
left. You can select more than one checkbox at a time. Note that the contacts to
join must already have been existent on the Addresses page.

6 Click Submit. You are returned to the Property page. To delete a contact, click
the X sign.

7 Click Submit again. Repeat the above steps to add more groups.

Editing a Group

1 Click Address Book in the navigation menu. The Addresses page appears.

2 Select the group you want to edit by clicking its Number or Name. The
Property page of the group opens.
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Alternatively, you can directly enter the group's Number in Address # window
and click Go to, or the group's Name in the Address Name window and click
the magnifying glass icon to search by name.

3 Modify the group's Number and Name as desired.

4 To add new contacts to the group, click the plus sign (+). The Addresses page
appears.

5 Select the contact to join in the group by selecting the Select checkbox to the
left. You can select more than one checkbox at a time.
You can filter contacts by selecting E-mail, Folder, FAX, or i-FAX on the Type
drop-down list.

6 Click Submit to add the contacts. You are returned to the Property page.

To delete a contact, click the X sign.

Deleting a Group

1 Click Address Book on the navigation menu. The Addresses page appears.

2 Select the group(s) you want to delete by selecting the check box to the left.

If you want all groups displayed on the page deleted, click Check All. To
deselect all, click None.

Note: Deleting a group does not delete the contacts joined in the group.

3 Click Delete. To cancel, click Back.
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6 Settings Pages

The Settings page divides the following functions onto separate pages. You
can jump to the desired pages by clicking the tab located at the top of each
page. The following is an outline of each page accessed, described on the page
as indicated below.
Start Page

This page allows you to verify the device’s current settings and, depending
on model, current operating status. For details, see page 6-1.

Basic Page
This page includes settings that apply to the entire device, such as Device
Defaults, Security, and Basic Networking. For details, see page 6-4.

Printer Page
This page includes settings that apply to the printing function of the device,
such as Default Print Resolution and Copy Count. For details, see page 6-
13.

Scanner Page
This page includes settings that apply to the scanning function of the device,
such as Default Scan Resolution and Original Placement. For details, see
page 6-15.

FAX/i-FAX Page
This page includes settings that apply to the FAX function of the device, such
as FAX transmit and receive settings. For details, see page 6-20.

Advanced Page
This page includes advanced settings that apply to the entire device and is
comprised primarily of advanced network settings. For details, see page 6-
31.

Start Page
The Start page lets you view to verify the following information of the device. To
gain access to this page, an administrator privilege is required.

• Verifying the device's operating status

• Verifying various settings (device, printing, FAX, scanning, network and E-
mail)

• Verifying the number of scanned pages and the number of prints made on the
device

Start > Status (Device/Printer Status Page)
The Device/Printer Status Page will be the first screen that appears after you
clicked on Settings on the home page. This page allows you to view status for
various functions on the device.
Device Details
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This indicates the device's model, serial number, asset number, firmware
information, etc.

Device Settings
This shows whether the administrator password is defined, the language the
embedded server is displayed in, and the status of Auto Sleep, A4-Letter
override, and Auto Error.

Device Options
This provides you with the information on installation of optional hardware
equipment, such as a document processor.

Printer Settings
System information on the printing system is displayed, allowing you to verify
the resolution, number of copies, gloss mode, EcoPrint mode, etc.

Time
This shows the time of day set in the printing system.

Media Input
This shows the size and media type for the paper loaded in the MP tray and
the cassettes.

Document Output
This shows stack mode of each paper output devices. Face down delivers
printed pages in forward order, whereas, Face up delivers printed pages in
reverse order.

Memory
This shows the total memory installed in the printing system in megabytes.

Advanced Options
This provides you with the information on advanced features currently
installed in the printing system. This includes Security Kit, Fax Kit, Card
Reader, etc.

Start > Status Pages
These pages allow you to verify the various settings (device, printing, scanning,
network and E-mail) that were made on the operation panel or using the
embedded server.
It is divided by the following items.

• Network

• Security

• Device/Printer

• Scanner

• FAX/i-FAX

• Counters

Network > General
This allows you to verify the current settings for LDAP, TCP/ IP, IPP, IPP
over SSL, AppleTalk, NetBEUI, IPv4, and IPv6. For more information, refer
to Advanced Page on page 6-31.

Network > IP Filters
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This displays the list of IP addresses and subnet masks (IPv4) or prefix
length (IPv6) that have access permission as set under IP Filters (IPv4) and
IP Filters (IPv6) on the Advanced page. If no IP addresses have been
designated, then access permission will be granted to all addresses. For
more information, refer to Advanced > Protocols > TCP/IP > IP Filters on
page 6-34.

Network > SNMP
This allows you to verify the settings made under SNMPv1/ v2 and SNMPv3
on the Advanced page. For more information on SNMPv1/v2, refer to
Advanced > Management > SNMP > SNMPv1/v2c on page 6-41. For more
information on SNMPv3, refer to Advanced > Management > SNMP >
SNMPv3 on page 6-43.

Network > POP3/SMTP
This allows you to verify the E-mail-related settings made on POP3 and
SMTP pages of the Advanced page. For more information on POP3, refer to
Advanced > E-mail > POP3 > General on page 6-40. For more information
on SMTP, refer to Advanced > E-mail > SMTP > General on page 6-38.

Network > Logical Printers
This allows you to verify the settings made on the Logical Printers page of
the Advanced page. For more information, refer to Advanced > Protocols >
TCP/IP > Logical Printers on page 6-35.

Network > NetWare
This allows you to verify the settings made on the NetWare page of the
Advanced page. For more information, refer to Advanced > Protocols >
NetWare on page 6-35.

Security
This allows you to verify the current settings for secure protocols,
IEEE802.1x, and IPSec. To change the settings: For secure protocols, refer
to Advanced > Security > Secure Protocols on page 6-48. For IEEE802.1x,
refer to Advanced > Security > IEEE802.1x on page 6-49. For IPSec, refer to
Advanced > Security > IPSec > Rule1 (to Rule3) on page 6-50.

Device/Printer
This allows you to verify the settings made on the Basic and the Printer
pages. For more information, refer to Basic Page on page 6-4 and Printer
Page on page 6-13.

Device/Printer > APL.Filter
This allows you to verify the settings made on the Basic and the Printer
pages. For more information, refer to Printer Page on page 6-13.

Device/Printer > APL.Filter Parameters
This allows you to verify the settings made on the Basic and the Printer
pages. For more information, refer to Printer Page on page 6-13.

Scanner
This allows you to verify the settings made on the Scanner page. For more
information, refer to Scanner Page on page 6-15.

FAX / i-FAX > General, FAX, i-FAX
This allows you to verify the settings made on the FAX / i-FAX page. For
more information, refer to FAX / i-FAX Page on page 6-20.

Counters > Printed Pages
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This allows you to verify the accumulated number of printed pages for each
paper size and color (Monochrome, Mono Color, and Full Color). A page
printed on both sides is counted as two pages.

Counters > Scanned Pages
Provide information of the number of pages copied, faxed, and other
(scanned), respectively.

Start > Information
This page provides information about user account.
User Login

This shows the number of registered users. For details, see Basic > Security
> User Login on page 6-10.

Basic Page
This section includes settings that apply to the device, such as Device Defaults,
Security, and basic Networking.

Basic > Defaults > Network
This page allows you to make the settings that are required for network printing
and sending E-mail. For more information, refer to Advanced > Protocols >
TCP/IP > General on page 6-32.
You must restart network or this machine after you have completed these
settings in order to properly register the content of those settings in the
machine. Refer to Basic > Defaults > Reset on page 6-6.
Host Name

Specifies a name for the printing system network component. This name is
used as the NetBEUI printer name and as the WSD device name.

LAN Interface
Specifies the communication rate from Auto, 10BASE-T-Half, 10BASE-T-
Full, 100BASE-TX-Half, 100BASE-TX-Full and 1000BASE-T.

IPv4 Settings

• DHCP/BOOTP
Specifies whether or not to obtain an IP address using DHCP or BOOTP.

• IP Address (IPv4)
Assigns the Internet Protocol address on the printing system network
component. Format of the IP address is four-byte (32-bit) numbers separated
by dots, for example, 192.168.110.171.

• Subnet Mask
Specifies the subnet mask of the hosts or network with which the print system
is connecting. If you have manually assigned an IP address that starts with a
number between 192 and 223, it is recommended that you set the subnet
mask to "255.255.255.0."

• Default Gateway
Specifies the IP address of the default gateway.

IPv6 Settings

• IPv6
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Specifies whether or not to enable the IPv6 protocol. Select On to use the
IPv6 protocol.

• IP Address (IPv6)
Assigns an IPv6 address to the printing system network component. The
format of the IPv6 address is a sequence of numbers (128 bit in total)
separated by colons, for example, 2001:db8:3c4d:15::1a2c:1a1f.

• Prefix Length
Specifies the IPv6 prefix length of the hosts or network with which the print
system is connecting.

• RA (Stateless)
Select On to use RA to configure IPv6 addresses.

• Default Gateway
Specifies the IPv6 address of the default gateway.

• DHCPv6
Specifies whether or not to obtain IPv6 IP addresses by automatic
configuration. When RA is turned On, the IP addresses and server
information are obtained via DHCPv6 based on the settings of the automatic
configuration made under RA (router setting).

Basic > Defaults > Time
If a time server is used to synchronize the time as well, the current time can be
adjusted regularly and easily. Enter the host name or IP address of the time
server and click the Synchronize button.
Time information is required when you receive reports from this machine via E-
mail. It is recommended that you set the time when the report mail function is
enabled.
Current Local Time

Displays the time that is currently set in the machine.
Current Universal Time (UTC/GMT)

Displays the Greenwich Mean Time that is currently set in the machine.
Time Zone

Sets a time difference. Click the drop down list and select your region.
Summer Time

Switches the Summer Time setting On and Off. Select On in order to have
the Summer Time function applied when the time is synchronized with a time
server.

Time Server
Enter the host name or IP address of the time server from which you want to
acquire the time.

Synchronize with Time Server now
Click the Synchronize button to synchronize the registered time with the
designated timer server.

Synchronization Status
Displays the results of the synchronization operation with the time server.
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Basic > Defaults > Reset
This page allows you to restart the machine in order to make all settings in the
machine valid. It is also possible to select to have all settings returned to their
factory default values.
Restart entire device

Clicking Restart restarts this machine.
Restart Network

Clicking Restart allows restarting the network interface without restarting the
machine. The network interface must be restarted whenever a change has
been made to the network settings.

Reset entire device to factory default
When clicking the Reset button, the machine returns to the factory default
settings. However, the document box, address book, user information, logs,
and certificates are not deleted.

Basic > Defaults > Device Defaults
This page allows you to change the language that is used in the display, to turn
Auto Sleep Mode on or off, etc.
Operation Panel Language

You can select the language of the messages on the display by following the
procedure given below. The following languages are available for selection
in the drop down list: English, Français, Deutsch, Italiano, Nederlands,
Español, Português, Russian, and the downloaded languages. You can
optionally download messages in other languages. Contact your dealer for
information. Some models may require restarting after configuration.

Sleep Timer
Specify the time in the drop-down list, from 1 to 240 minutes, after that the
system enters Auto Sleep Mode. On some models, you can choose how the
machine wakes up and reverts to normal mode of operation in Quick
Recovery or Energy Saver as described below.
Proceed as follows to complete sleep mode settings:

1 Click Advanced on the right hand side of the Sleep Timer drop-down list.

Note: Advanced settings are not available when a FAX Kit is installed in the
machine.

2 Turn Auto Sleep On or Off. If you select Off, Sleep Timer is disabled and the
machine will not enter sleep mode.

3 In Sleep Level, select Quick Recovery or Energy Saver.
Quick Recovery automatically lets the machine recover from sleep mode when
the machine receives a print data via any interface (network, USB port, etc.).
With Energy Saver, printing does not take place until you make a key operation
on the machine operator panel.
Alternatively, on some models, the Sleeping page appears on the embedded
web server while the system is engaged in Energy Saver. You can click Start on
the Sleeping page.
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If you have selected Energy Saver mode of sleeping, click On of the appropriate
radio button for the interface or device you would like to engage in Energy
Saver. Click Off if you do not want to engage Energy Saver for the interface or
device. For example, if you want print data received by the network interface to
automatically wake the machine and be printed, click Off next to Network.

4 Click Submit.

Override A4/Letter
Specifies whether or not the A4 and Letter size paper should be
interchangeable. When turned On, for example, if the A4 paper is not in the
tray, the Letter size paper will be selected for printing. When turned Off, the
Letter size paper will not be used in place of the A4 paper, when A4 is
selected for printing but the A4 tray is empty.

Auto Error Clear
Turns Auto Error Clear, which automatically clear errors when they occur, on
or off.

Error Clear Timer
Specifies the time between 5 and 495 seconds after which errors are cleared
automatically.

Low Power Timer
Specifies the time from 1 to 240 minutes after which the system enters the
low power mode, where it reduces the power consumption.

Interrupt Clear Time
This determines the time of period before the machine reverts to normal
mode, after the interrupt copy mode has been engaged. The range is 5 to
459 seconds (in 5-second increments).

WSD Scan Timer
This determines the time of period before the machine reverts to normal
mode, after WSD scan mode has been engaged. The range is 10 to 495
seconds (in 5-second increments).

RAM Disk Mode
Specifies whether to use a part of the print system memory as a RAM disk.
You can specify the size of the print system memory to use for the RAM disk.
If this item is On, electronic sorting is enabled and the printing speed
increases. After you have changed the setting, you must restart the printing
system.

RAM Disk Size
Specifies the size of the RAM disk. For allowable sizes, refer to the print
system operation guide. After you have changed the setting, you must
restart the printing system.

File Name
You can change the file name for the scan data or the job name for the jobs
on the Job page.

Additional Information
You can add a Job Number or the Data and Time to the File Name
designated above. The additional information varies depending on model.

Skip Error Job
Turns Skip Error Job on and off, which automatically terminates processing a
job on an error and skips to process the next job. The time of period (interval)
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for the system to wait until the job is skipped can be set by Set Interval
below.

Set Interval
Selects the time of period until Skip Error Job is activated from 5 to 90
seconds.

MP Tray Empty
With the MP tray set as the default paper source, this enables (On) or
disables (Off) the paper empty message when the MP tray becomes empty.

Unusable Time Setting (when FAX is installed)
This restricts use of the machine by time of day. When turned On, the
machine becomes inoperative during the time of day specified by Unusable
Time. Except, the received faxes are stored in the machine and printed after
the inoperative time period has been expired.

Unusable Time
This determines the time of period during which the machine is restricted for
use. This is enabled when Unusable Time Setting is On.

Unlock Code
Entering this code, comprised of four digits from 0 to 9, temporarily allows
the machine to be usable during the time of period of restriction.

Dest(ination) Check Before Send
This enables the front panel message which prompts you to confirm the
destination to forward the scan data. The message is displayed when the
machine's Start key is pressed to start scanning.

Entry Check for New Dest(ination)
When enabled, this determines whether re-entry of a password for
confirmation is required when adding a new destination.

Default Screen (Send/FAX)
You can select either Destinations or Address Book to be displayed by
default on the print system's display while using send or FAX mode.

USB Keyboard Type
This tells the system the type of the keyboard being connected to the USB
port. In order for the keyboard to properly operate, specify the correct type.

Low Toner Alert Level
This determines the level of remaining toner to alert that toner is running low.
When On, Toner Level (see below) becomes active to select a threshold.
When Off, the threshold is fixed to 5% of the remaining toner.

Toner Level
Adjusts the level of remaining toner to alert low toner.

Offset One Page Documents
This turns offset stacking On or Off when printing documents comprised of
only one page.

Main Memory/Option Memory
You can determine how memory usage is optimized in the machine in three
ways. Choose from Printer Priority, Normal, and Copy Priority depending
on the type of jobs you mostly use with the machine.
For some models, this menu is available only when an optional memory is
installed.

Embedded Web Server RX 6-8



Settings Pages

Display Jobs Log
This provides the option to change the administrators and users who may
see the jobs log. You can select Hide All to allow only the administrators
who logged in using administrator privilege to see the jobs log. Show All
allows all administrators and users to see the jobs log.

Location
Normally the location of the device should be specified.

Message Banner Print
Each time a banner page is printed, the machine halts and displays a
message that prompts you to continue banner printing. You can activate
(On) or deactivate (Off) this message.

Paper Size for Small Original
Selects a paper size when an original of a small paper size, such as a card,
which the scanner cannot detect is printed.

Basic > Security > Device Security > General
This page allows you to restrict access from the operation panel or USB host
device. In addition, an explanation about each security setting is displayed.
Lock Operation Panel

Restricts access from the operation panel. With some models, this setting is
irrelevant if the user has logged in as the Administrator.
When it is set to Lock (Block), use of the System menu on this machine,
registration in and editing of the Address Book and Box, use of the Stop key,
and cancellation of jobs are forbidden. When it is set to Partial Lock, use of
the System menu on this machine and registration in and editing of the
Address Book and Box are forbidden. When it is set to Unlock, use of all
keys is permitted.

Filtering/Firewall, SNMPv1/v2, SNMPv3, SSL, IPSec, IEEE802.1x
An explanation about each security setting is displayed. When you click a
link in the sentence, the appropriate tab of the Advanced page opens.

Basic > Security > Device Security > Interface Block
This page allows you to restrict access from each interface.
Network, USB Device, USB Host, USB Storage, Parallel I/F, Optional I/F
(1/2)

Specifies whether or not to restrict access from each of the interfaces above.
Access from the interfaces that are set to Block is restricted.
Access from the network interface cannot be restricted. Access can be
restricted on a per-protocol basis. Refer to the next section.

Basic > Security > Device Security > Network Security
This allows you to enable communication with the printing system on a per-
protocol basis.
SNMP v3, NetWare, AppleTalk, NetBEUI, Raw, IPP, IPP over SSL, HTTP,
HTTPS, FTP (Transmission), FTP (Reception), SMB, SNMP, SMTP, POP3,
LPD, LDAP, WSD Scan, WSD Print, ThinPrint, Enhanced WSD, Enhanced
WSD over SSL, DSM Scan

Specifies whether or not to restrict communication via each of the protocols
on the left. The communication via the protocols that are set to Block is
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restricted. The settings made on this page affect the protocol settings on the
Advanced page.

Basic > Security > User Login
When the authentication function is set on the Advanced > Management >
Authentication page (Local Authentication, depending on model), you must
register users and set access levels on this page. The available access levels
are User and Administrator.
One administrator account is registered by default.

Local Authorization turns On or Off Job Authorization settings for a user
listed on User List.
Registered shows the number of the current users. By entering a user name
in Search by Name, you can search for the user.

Adding a New User Login

1 Click User Login, open the User Login page.

2 Click Add and enter the information of the user.

3 Click Submit.

Editing a User Login

1 Click User Login, open the User Login page.

2 Click the desired Login User Name or User Name to edit the user and modify
their information.

3 Click Submit.

Deleting a User Login

1 Click User Login, open the User Login page.

2 Check the desired user. When the check box on the left side of Login User
Name is selected, all users displayed on the page will be checked.

3 Click Delete. The User Login - Delete page appears. You can confirm the
users to be deleted.

4 Click Delete when the desired users are selected.

Basic > Security > Certificates
This page allows you to create or update certificates or check details on
certificates. After you have changed this setting, you must restart network or this
machine. For the restarting procedure, refer to Basic > Defaults > Reset on
page 6-6.
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Device Certificate - Self Issued

The self-issued certificate is automatically issued by default. The automatically
issued certificate has the country code, common name, and a validity period of
about 10 years already configured.
Self Certificate

Displays whether the certificate is active.
Expiration

Displays the validity period of the certificate.
View Certificate

Click View to view details on the certificate.
Create Certificate

Click Create to create a certificate.
Country code and common name are mandatorily required. On Windows
Vista/7, the common name and the access name (host name or IP address)
must be identical.

Edit Certificate
Click Edit to show Current Universal Time, and update the validity period of
the certificate.

Export Certificate
Click Export to display the download dialog for the file. Click Save to
download the exported certificate.
If the printing system supports self-issued certificates only, it cannot carry
out encrypted communication via IPP over SSL with Windows Vista/7
because the IPP over SSL function of Windows Vista/7 does not deem self-
issued certificates as trusted. To enable printing via IPP over SSL, export the
self-issued certificate from the printing system and import it into Windows
Vista/7 as a trusted certificate. In this case, the access name must match the
common name of the certificate.

Device Certificate - CA Issued

CA Certificate
Displays whether the certificate issued by the Certification Authority (CA) is
active or not.

Expiration
Displays the validity period of the certificate.

View Certificate
Click View to view the details of the certificate.

Import Certificate
Click Import to open the File Import window. Click Browse to open the file
selection dialog box. Select a file and click Open. When the certificate is
password-protected, enter the password and click Submit. The certificate is
imported.

Delete Certificate
Click Delete. The certificate is displayed. Click Delete again to delete the
certificate.
When the CA issued certificate is deleted, the settings are made invalid if
Authentication Type is set to Certificates for IPSec. The self-issued
certificate is made valid for SSL.

6-11 User Guide



Settings Pages

Root Certificate

Root Certificate
Displays whether the certificate is active.

Expiration
Displays the validity period of the certificate.

View Certificate
Click View to view details on the certificate.

Import Certificate
Click Import to open the File Import window. Click Browse to open the file
selection dialog box. Select a file and click Open. Click Submit to import the
certificate.

Delete Certificate
Click Delete. The certificate is displayed. Click Delete again to delete the
certificate.
When all root certificates are deleted, the settings are made invalid if
Authentication Type is set to Certificates for IPSec. In addition,
IEEE802.1x is turned Off.

Application Certificate

IEEE802.1x Client Certificate
Displays whether the certificate is active.

Expiration
Displays the validity period of the certificate.

View Certificate
Click View to view details on the certificate.

Import Certificate
Click Import to open the File Import window. Click Browse to open the file
selection dialog box. Select a file and click Open. Enter the password and
click Submit. The certificate is imported.

Delete Certificate
Click Delete. The certificate is displayed. Click Delete again to delete the
certificate.

DSM Scan Client Certificate
Displays whether the certificate is active.

Expiration
Displays the validity period of the certificate.

View Certificate
Click View to view details on the certificate.

Import Certificate
Click Import to open the File Import window. Click Browse to open the file
selection dialog box. Select a file and click Open. Enter the password and
click Submit. The certificate is imported.

Delete Certificate
Click Delete. The certificate is displayed. Click Delete again to delete the
certificate.
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Printer Page
This section includes settings that apply to the printing function of the machine,
such as default print resolution or copy count.
Default printer settings will be overridden by the printer driver settings. Settings
that affect the machine entirely, such as locking the operation panel, are found
under Basic Page on page 6-4.

Printer > Summary of Network Printer Access Methods
The following information that has already been set is displayed here.

• IP Address
• Host Name
• Net BEUI Name
• AppleTalk Name

Printer > System
The table below provides a summary of the items displayed on the System
page.
Form Feed Timeout

Adjusts the timeout between 5 and 495 seconds, after which a form feed will
occur in the absence of data. The default setting is 30 seconds.

Emulation
Selects an emulation mode.

Alternate Emulation
Specifies which emulation mode should be used for processing at the time
data other than KPDL is received, when AUTO is selected for emulation.

JPEG/TIFF Print
This determines the physical size of JPEG images when printing them from a
USB flash device. Choices include Fit to Paper Size, Image Resolution,
and Fit to Print Resolution.

XPS Fit to Page
This determines the page size for printing XPS data. Turn On to fit print data
over the page size; and turn Off to print in the original size.

Paper Feed Mode
Determines the behavior of paper feed selection when the paper you
requested of size and/or type is not available in the current paper source.
Auto lets the machine to search for the matching paper including all the
paper sources. Fixed does not perform searching in the other paper
sources.

Duplex Mode
Selects the default duplex mode from Off, Long Edge and Short Edge.
Available on machines with the duplex printing.

Copies
Sets the number of copies to print.

Page Orientation
Switches Portrait or Landscape page orientation.
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Gloss Mode
Sets Gloss Mode to On or Off. The default setting is Off. Available for some
color machines which support Gloss Mode.

Color Mode
Sets Color Mode to Black & White (Monochrome) or Full Color. Available
for some color machines.

KIR Mode
Switches KIR smoothing On or Off. Available for some machines.

EcoPrint Mode
Switches EcoPrint On or Off to control toner consumption for saving the
printing costs. The default setting is Off. Available for some machines.

Toner Save Level
Selects Toner Save Level from 1(Low) [low saving, darker printing] to
5(High) [high saving, lighter printing] when EcoPrint Mode is On.

Printer > System > APL.Filter (Japan only)
This page allows you to configure the APL.Filter. The APL.Filter is a function
that converts the received print data to the specified code and prints that data.
Filter

Switches the APL.Filter On or Off.
Filter Name

Selects the APL.Filter. You can select the ASCII to KPDL conversion
process.

Printer > System > APL.Filter Parameters (Japan only)
Configure items that can be set differently between APL.Filters. You can specify
fonts and the text to be converted.
Font

Specifies the fonts used for printing.
Start of String

Specifies the character string with which the text to be converted begins. Up
to 15 single-byte characters can be specified.

End of String
Specifies the character string with which the text to be converted ends. The
default setting is \f. Up to 15 single-byte characters can be specified.

Printer > Media Input
This page lets you configure paper trays by type and size. You can also
configure cassette groups.
Default

Determines the default tray to feed paper from.
Tray

Displays the trays including those provided by option.
Size
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Displays the paper size for each input tray. This setting can be changed
using the dropdown list.

Type
Displays the paper type for each input tray. This setting can be changed
using the dropdown list.

Group Settings
If multiple cassettes are available, you can set up to three groups of
cassettes. Cassettes in a group are treated as a single tray. Paper can be
fed continuously from the grouped cassettes.

Printer > Document Output
This page lets you select an output tray.
Paper Output

Determines the default output tray.

Scanner Page
This section includes settings that apply to the scanning function of the
machine, such as default scan resolution or original placement.
In order to attach scanned data file to an E-mail and send it, the SMTP settings
on the Advanced page must be completed.

Scanner > Defaults
The section below provides a summary of the items displayed on the Scanner >
Default page.
Color Selection (Copy)

This selects color mode for copying. Auto automatically identifies full color or
black and white from the original document to copy. You can manually select
either Full Color or Black & White to forcedly switch color mode.

Color Sel.(Send/Store)
This selects color mode for scanning or storing. Auto Color
(Color/Grayscale) and Auto Color (Color/Black & White) allow you
identify color for the original document to scan. You can manually select Full
Color, Grayscale, or Black & White to forcedly switch color mode.

Scan Resolution
Specifies the resolution. The maximum resolution using full color or gray
scale mode is 300 x 300 dpi. To scan in full color or gray scale with 400 dpi
or 600 dpi resolution, expansion of the internal memory is required.

Original Image (Copy)
The original quality for copying is selected according to the type of original.
Select from Text+Photo (Printer Output), Text+Photo (Book/Magazine),
Photo (Printer Output), Photo (Book/Magazine), Photo (Photo Paper),
Text (Light Text/Fine Line), Graphic/Map (Printer Output), and
Graphic/Map (Book/Magazine).

Original Image (Send/Store)
The original quality for scanning/storing is selected according to the type of
original. Switch the original quality from Text, Text+Photo,and Photo.

File Format
Selects the file format in which the scanned data will be saved.
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PDF/A
Turns PDF/A-compliant format PDF/A-1a or PDF/A-1b on or Off, when File
Format above is PDF. PDF/A is an electronic document file format for long-
term preservation as addressed in the ISO 19005-1 specification.

Image Quality (File Format)
Selects the file quality mode (1 [Low] to 5 [High]) in which the scanned data
will be saved.

High-Compression PDF Image
Selects the compression rate for PDF files from 1 (Low), 2 (Medium), and 3
(High).

High-Compression PDF Auto Color
Sets whether to enable or disable the automatic color/ monochrome
detection for the original to be scanned.

Zoom
Switches the zoom ratio between Auto and 100%. The default setting is
100%.

Original Orientation
Switches between Top Edge Top and Top Edge Left.

Scanner > FTP
This section provides a summary of the items displayed on the FTP page.
FTP

Switches FTP On or Off.
FTP Port Number

Sets the FTP Port Number or use the FTP default port 21.
FTP Encrypted TX

This enables or disables Encryption for communication. When turned On,
the encryption algorithm that is selected by Advanced > Security > Secure
Protocols on page 6-48 is used.

Scanner > SMB
The table below provides a summary of the items displayed on the SMB page.
SMB Protocol

Switches the SMB Protocol On or Off.
SMB Port Number

Set the SMB port number in the field provided, or use the SMB default port
139.

Scanner > E-mail
The E-mail page is used for creating an E-mail template. The template includes
a subject line, and three fields for entering body information of the E-mail. The
E-mail page details are summarized in the following:
Subject

The subject line of an E-mail can include the model name of the printer,
serial number, MAC address, host name and IP address information.
Designated conversion strings are provided for this purpose, starting with %.
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The string will be converted into a pre-defined string to display the selected
information. The Subject Conversion Strings are detailed as follows:

• %printer = Model
• %serial = Serial Number
• %etheraddr = MAC Address
• %host = Host Name
• %ip = IP Address

Body
You can enter the information that you want to appear in the body of the E-
mail in the 3 fields provided.

Scanner > Send and Forward
When sending a FAX, FTP, SMB, i-FAX or a E-mail job, Send and Forward
automatically forwards the same job to a destination specified. The following
section provides a summary of the items displayed on the Send and Forward
page.
Forward

Switches Send and Forward On or Off.
Rule

Selects a rule of either FAX, i-FAX, FTP, SMB or E-mail to activate Send and
Forward.

Forward settings
Allows to edit the job to send and forward.

Color Selection
This selects color mode for scanning or storing. Auto Color
(Color/Grayscale) and Auto Color (Color/Black & White) allow you
identify color for the original document to scan. You can manually select Full
Color, Grayscale, or Black & White to forcedly switch color mode.

Scan Resolution
Specifies the resolution. The maximum resolution using full color or gray
scale mode is 300 x 300 dpi. To scan in full color or gray scale with 400 dpi
or 600 dpi resolution, expansion of the internal memory is required.

File Format
Selects file type to stored the scanned document.

PDF/A
Turns PDF/A-compliant format PDF/A-1a or PDF/A-1b on or off, when File
Format above is PDF. PDF/A is an electronic document file format for long-
term preservation as addressed in the ISO 19005-1 specification.

Image Quality (File Format)
Selects the file quality mode (1 [Low] to 5 [High]) in which the scanned data
will be saved.

High-compression PDF Quality
Selects the compression rate for PDF files from 1 (Low), 2 (Medium), and 3
(High).

File Separation
Scans a multi page document and saves each page as a separate file.
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Subject
Subject is entered here.

FTP Encrypted TX
This enables or disables encryption for communication. When turned On, the
encryption algorithm that is selected by Advanced > Security > Secure
Protocols is used.

Encrypted PDF Settings
Apply encryption to the PDF files to send-and-forward.

Compatibility
You can change the PDF version by choosing a compatibility option when
you save as PDF.

Password to Open Document
When you set a Document Open password, anyone who tries to open the
PDF must type in the password you specify. Set to On and enter a Document
Open password.

Password to Edit/Print Document
You can set a password to restrict recipients to print or edit the document, or
copy its contents, such as images. Recipients don't need a password to
open the document, but they must type the password to accomplish one of
these restricted actions to the document, respectively.

• Printing Allowed
Restrict printing of the document.

• Changes Allowed
Restrict editing of the document.

• Copying of Text/Images/Others
Allow copying objects including images and text for pasting into other
document.

To require a password in order to protect the document, click On and enter the
password.
Add

Adds a destination for forwarding. To add a destination, proceed as follows:

1 Click Add.

2 In Address Type, select the type of destination from the following:

• Email - forwards E-mail to the E-mail address entered.
• SMB - forwards SMB scan jobs to a shared folder on Microsoft Windows

network. Enter the Host Name, Port Number, path to a shared folder, Login
User Name, and the Login Password.

• FTP - forwards FTP scan jobs to an accessible FTP server. Enter the Host
Name, Port Number, path to a folder, Login User Name, and the Login
Password.

Adding an Address from an Address Book
To add an address from an Address Book, if set up, proceed as follows:

1 Click Import Contacts.
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2 The address book opens. Check the check box for the address you want to add
to the destination.

3 After you have finished selection, click Submit.

4 The Send and Forward page appears. Check that the destination is added to
the destination list.

Delete
To delete a destination from Destination Settings, click the check box next
to the destination, then click Delete. If you accept the confirming prompt,
click Delete.

Scanner > i-FAX
This sends scanned data in i-FAX mode. The subject and body contents for i-
FAX must be specified. The contents displayed on this page are the same as in
Scanner > E-mail, described above.

Scanner > DSM Scan
DSM (Distributed Scan Management) is a Microsoft definition of scanner
management systems over the Windows networks. The administrator can use
the Windows Server 2008 R2 scan management to obtain ScanProcess for
each user and add them to ActiveDirectory. This will allow the user to execute
scanning according to the scan process.
DSM Scan

Switches DSM Scan On or Off. Select Network Authentication for the
Authenticate Mode setting to use DSM Scan. Note that the SSL protocol
must also be turned On.

Client Certificate Type
Selects either the CA Certificate or DSM Scan Client Certificate for the
client certificate type. You must restart network or this machine after you
have completed this setting in order to properly register the content of those
settings in the machine.

LDAP Server Name
Specifies a name or IP address for the LDAP server. This is required only if
ActiveDirectory which contains ScanProcess is unidentical with the server
for the network authentication.

LDAP Port Number
Specifies a port number for LDAP or use the LDAP default port, 389.

Search Timeout
Specifies a period of time for searching the LDAP server.

LDAP Security
Selects the type of encryption from the drop-down list, according to the type
of security employed by the LDAP server. Select Off when encryption is not
used.

Authentication Type
Selects either the Simple or SASL for the authentication type.

CA Certificate

6-19 User Guide



Settings Pages

Displays whether the certificate issued by the Certification Authority (CA) is
active or not.

Root Certificate 1 (to Root 3)
Displays whether the certificate is active.

DSM Scan Client Certificate
Displays whether the certificate is active.

FAX / i-FAX Page
This section includes settings, such as FAX transmission and reception
settings, that apply to the FAX function of the device. For models i-FAX is not
activated, i-FAX settings are not displayed on the page and FAX is displayed on
the menu.

FAX / i-FAX > Common > Defaults
The table below provides a summary of the items displayed on the FAX / i-FAX
> Common page.
Local FAX Name

Specifies your FAX system name.
Furigana (Japan only)

This adds phonetic scripts to the FAX system name.
Account as Local FAX Name

Set to On to use the account name as the local FAX name. The account
name appears in place of the local FAX name.

FAX / i-FAX > Common > Receive
The table below provides a summary of the items displayed on the Receive
page.
FAX Media Type

Sets the media type for printing the received documents.
Use MP Tray

Selects whether or not to include the MP (multi purpose) tray for auto media
selection when printing received documents. When turned On, the MP tray
will be included as an option for auto media selection, and when turned Off,
only the cassettes will be selected.

Reduced RX Size
Specifies the printing configuration for printing a document, which is larger
than the selected paper size. When Same Size Override is selected, the
document will be printed on multiple sheets of paper without reducing the
text. When Reduction Override is selected, the document will be printed on
one sheet whenever possible.

Receive Date/ Time
Selects On or Off whether to print the reception information such as the
received date, the received time, the transmitting party's information and the
number of transmitted pages on the top of the received documents.

Duplex Printing
Specifies whether or not to use the Duplex mode.

2 in1 Receive
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Enables or disables 2 in1 reception.

FAX / i-FAX > Common RX/Forward Requirements > General
Conditional reception/forwarding is a function for automatically forwarding
documents received by FAX or i-FAX to other FAX machines, sending them as
attachments to E-mail, or saving them into a FAX Box instead of printing if they
satisfy the specified conditions.
For example, you can forward faxes from particular customers received during
business hours to the E-mail addresses of the people responsible for those
customers, print and save them in a FAX Box if they are received outside
business hours, and forward faxes from outside of your business area to the
business office nearest to the sender's fax number.
For models that do not support RX/Forward Requirements, the documents
received are forwarded in the same requirement.

Types of RX/Forward Requirements

Open the FAX/i-FAX > Common > RX/Forward Requirements > General
page. Select one of the following items.
Off

Disables the forwarding process. Received faxes are printed on paper as in
normal operation.

Use Requirements List
Executes the forwarding process according to the specified conditions. For
the setting procedure, refer to Setting Destinations on page 6-25.

All
Executes the forwarding process without specifying conditions. All received
faxes are processed in the same way. However, the process of saving them
in a FAX Box cannot be selected. Clicking Advanced specifies a setting
equal to that all conditions are specified. For the setting procedure, refer to
Settings for Applying the Same Forwarding Process without Using a
Requirement List on page 6-24.

Settings for Forwarding Processes Using a Requirement List

Open the FAX/i-FAX > Common > RX/Forward Requirements >
Requirement List page.

1 Add the new condition to the Requirement List. Click Add.

2 The Requirement List - Add page appears. Specify the condition for the FAX
forwarding process.
Requirement Number

Enter a number that identifies the condition set.
Name

Give the condition set here an easily recognizable name.
Status

Specify whether to enable or disable the condition. This item is set to Off for
the condition that has just been added. To set this item to On, set the
conditions and then click to select the desired condition on the Requirement
List and change the setting. If the requirement sets include the same
Activating Time Setting, Activating Time and Sub Address settings,
these requirement sets will not be enabled at the same time.
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Activating Time
Specify a period of hours during which the forwarding process is executed.
Select Time Specification to forward only faxes received during a particular
period of hours or All Day not to specify the hours.

Enable Time
When Time Specification is selected in the previous item, specify the start
time and end time.

File Name
Specify the file name to be used for the forwarded file.

Additional Information
Specify the information to be added to the file name specified in the previous
item.

Add Sender Information
Determine whether the sender information are added to the file name or not.

Priority
Prioritize the search keys when conducting searching over the sending
criterions.

Requirement Type
Select the condition type from the following items: FAX Sub Address, FAX
Number, FAX Reception Port, i-FAX Address
When an item is selected, the text box below it accepts entry of the
necessary information on the selected item. Enter the condition necessary
for each item. Asterisks (*) can be used as wildcards. For example, to
specify all faxes that came from Tokyo, select FAX Number and enter '03*'
in the FAX number text box. For some models which shows Search by when
FAX Number or i-FAX Address is selected, you can use a search criteria
such as Same as or Start with, etc. Wildcards cannot be used for these
models.
When the search criteria is Same as, up to 9 are forwarded to the FAX Box.
FAX Reception Port shows the list in which you can select Port 1 or Port 2. If
a reception port is contained in the condition, FAX reception cannot be saved
in a FAX box.
If you selected FAX Sub Address for Requirement Type, enter a
subaddress subsequently.

3 After you have finished setting all items, click Submit.

4 The Requirement List page appears. Check that the condition you have set is
added to the Requirement List. Click the name of the condition under which
you want to execute the forwarding process. The Detail/Edit page opens. Set
Status to On.

5 Then, specify how the forwarding process is executed. Click the desired items
among the following three Action Settings items in the lower part of the same
page. When you want to execute multiple forwarding processes at the same
time, for example printing and saving in a FAX Box, click both items and set the
processes.
Print

Prints received documents on paper.
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• Name
Displays the condition name.

• Status
Displays whether the condition is currently used.

• Print
Specifies whether to print on paper.

• Copies to print
When the previous item is set to On, specify the number of copies.

Forward
Forwards received documents to other FAX machines, E-mail addresses,
shared folders, and so on.

• Name
Displays the condition name.

• Status
Displays whether the condition is currently used.

• Forwarding
Turn On to enable forwarding.

• File Format
Selects the format of forwarded files from PDF, TIFF, or XPS. (This item has
effect when the forwarding destination is E-mail, SMB, or FTP.)

• FTP Encrypted TX
Turn On to enable encryption for transmission. Note the SSL protocol must
also be turned on. Refer to Advanced > Security > Secure Protocols on page
6-48.

• Subject Additional Information
When a forwarding address is specified as destination, Sender Name or
Sender FAX No./Address is appended at forwarding. When None, these will
not be appended.

• Page Separate
Specifies whether to split the fax into files as many as the number of pages.
Select On to split the fax. (This item has effect when the forwarding
destination is Email, SMB, or FTP.)

• Number of Destination
Displays the number of registered destinations displayed for the next item.

• Destination List
Displays a list of registered forwarding destinations. Faxes are forwarded to
all destinations displayed here. For how to add a destination, refer to Setting
Destinations on page 6-25.

Save to FAX Box
Saves received documents in a FAX Box.

• Name
Displays the condition name.

• Status
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Displays whether the condition is currently used.
• Save to FAX Box

Specifies whether to save faxes in a FAX Box. This is not stored in the FAX
Box if the forwarding conditions do not meet.

• Box Name
Specifies the FAX Box to be used. When the selection button is clicked, a list
of registered FAX Boxes appears. The FAX Box to be specified here must be
registered in advance. For how to add a FAX Box, refer to FAX Box on page
4-5.

6 After you have finished setting all items, click Submit.

7 The screen returns to the Detail/Edit page. After you have finished setting all
items, click Submit.

8 The Requirement List page appears. Check that the status of the condition you
have set is On. Repeat the above steps to set more conditions.

9 Finally, set the process for faxes that do not satisfy any of the conditions on the
Requirement List. Click Advanced of Not complying with the requirements.

10 The Requirement List - Advanced page appears. Set whether to execute
forwarding processes for faxes satisfying no conditions by setting the status to
On or Off. When this item is set to On, set the subsequent items. The procedure
is almost the same as the procedure for adding a condition. See steps 2 to 6 as
a reference.

11 After you have finished setting the items, click Submit.
This completes the settings for forwarding processes using a Requirement
List.

Settings for Applying the Same Forwarding Process without Using a
Requirement List

Open the FAX/i-FAX > Common > RX/Forward Requirements > General
page.

1 Click Advanced in RX/Forward Requirements.

2 The RX/Forward Requirements - Advanced page appears. Specify the
forwarding process. The procedure is almost the same as the procedure for
adding a condition. See steps 2 to 6 as a reference.

Note: The process of saving faxes in a FAX Box cannot be selected as the
forwarding process to be applied without using a Requirement List.

3 After you have finished setting the items, click Submit.

4 Returns to the RX/Forward Requirements page. Select ALL and click Submit.
This completes the settings for applying the same forwarding process without
using a Requirement list.
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Setting Destinations
When setting Forwarding in Action Settings described above, you have to
register Destination in advance. You can add a new destination or an address
registered in the address book to Destination.

Addition

Open the Action Settings > Forward page.

1 Click Add.

2 Select the desired type of forwarding process from Address Type. The
available types are as follows:
E-mail

Forwards faxes by E-mail. Specify E-mail address.
SMB

Saves faxes in a shared folder accessible from Microsoft Windows Network.
Specify Host Name, Port Number, Path to the shared folder, Login User
Name, and Login Password.

FTP
Saves faxes on an accessible FTP server. Specify Host Name, Port
Number, Path to the folder, Login User Name, and Login Password.

FAX
Forwards faxes to other FAX machines. Specify FAX Number, Transmit
Start Speed, and other necessary information on the forwarding
destinations.

i-FAX
Forwards faxes to other i-FAX systems. Specify i-FAX Address,
Connection Mode, and other necessary information on the forwarding
destinations.

3 After you have finished specifying the destination, click Submit.

4 The Action Settings > Forward page appears. Check that the Destination is
added to the Destination List.

Addition from the Address Book

There are two types of address book: address book contacts and address book
groups. In address book contacts, each entry has an address of one person. In
address book groups, each entry has multiple addresses. When an address of a
group is added, faxes are forwarded to all addresses registered in the group.
Before adding an address from an address book, you have to register the
address in the address book. For how to register an address in an address
book, refer to Contacts on page 5-1 or Groups on page 5-2.
Open the Action Settings > Forward page.

1 Click Import Contacts or Import Groups.

2 The address book opens. Put a check mark in the check box for the address or
group you want to add to the destinations.
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3 After you have finished selection, click Submit.

4 The Action Settings > Forward page appears. Check that the Destination is
added to the Destination List.

Deletion

You can delete a Destination from the Destination List.
Open the Action Settings > Forward page.

1 Put a check mark in the check box for the destination you want to delete from
the Destination List.

2 After you have finished selection, click Delete. The Action Settings > Forward
- Delete page appears. You can confirm the destinations to be deleted.

3 After you have finished selection, click Submit.

4 The Action Settings > Forward page appears. Check that the Destination is
deleted from the Destination List. After confirming the settings, click Submit.

FAX / i-FAX > FAX > Defaults
The description below provides a summary of the items displayed on the FAX /
i-FAX > FAX > Defaults page.
Local FAX Number (Port 1/ 2)

Specifies your FAX system number.
FAX Line

Sets the type of phone line to correspond to the type of telephone service
that you are using. Be sure that the type of phone line you select is correct
because, if the setting is incorrect, dialing will be impossible. The choices are
Tone (DTMF) or Pulse (10pps), or Pulse (20pps).

Local FAX ID
Specifies your FAX system ID.

Speaker Volume
Sets the volume of the internal speaker that allows you to listen to the other
party or to verify the conditions on the telephone line when the [On-Hook]
key was pressed. The choices are Off and levels 1 through 5.

Monitor Volume
Sets the volume of the internal speaker that allows you to verify the FAX
tones during FAX communication. The choices are Off and levels 1 through
5.

FAX / i-FAX > FAX > Transmit
The table below provides a summary of the items displayed on the Transmit
page.
TTI

Selects On or Off whether to send the TTI (Transmit Terminal Identifier)
information to other party.
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TTI Position
Selects the position of the TTI to be printed on the transmitted documents.

TX Start Speed
Selects the speed rate at starting transmission from 33600bps, 14400bps,
and 9600bps. Once communiation is established, the speed rate that is
slower than the other is employed.

ECM TX
Turns error correction mode on which corrects errors that may happen
during communication. To use error correction, error correction mode must
be turned on at both parties.

FAX / i-FAX > FAX > Receive
The table below provides a summary of the items displayed on the Receive
page.
FAX Receive

Selects the FAX reception mode. The choices are Auto (Normal, FAX/TEL,
TAD or DRD) or Manual. (The selectable option is different depending on
the destination.)

DRD Pattern
Selects the DRD pattern. This menu is available only for specific
destinations.

Number Display
Displays the caller's phone number if the service has been contracted.
(Available only in Japan.)

RX Start Speed
Selects the speed rate at starting reception from 33600 bps, 14400 bps, and
9600 bps. Once communication is established, the speed rate which is
slower than the other is employed.

ECM Reception
Turns error correction mode on which corrects error that may happen during
communication. To use error correction, error correction mode must be
turned on at both parties.

Remote Switching Dial Number
Specifies the remote switching dial number. You can specify it within a range
of 00 to 99. Remote switching allows you to initiate FAX reception from a
telephone connected to the FAX system.

Encryption Key No.
Sets the encryption key number to be used for encrypted communication.

F-NET
Sets the silent reception. (Available only in Japan.)

Dial-in
Activates the dial-in (direct number) call. (Available only in Japan.)

Dial-in Number
Specifies the telephone number for direct number. (Available only in Japan.)

Reception Port
Sets the receive-only port. (Available in multiport mode).
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Number of Rings (Normal)
Specifies the number of rings for Auto FAX reception (Normal). You can
specify it within a range of 1 to 15.

Number of Rings (TAD)
Specifies the number of rings for Auto FAX reception (TAD). You can specify
it within a range of 1 to 15.

Number of Rings (FAX/TEL)
Specifies the number of rings for Auto FAX reception (FAX/TEL). You can
specify it within a range of 0 to 15. This is not displayed on European
models.

FAX / i-FAX > FAX > FAX Restrictions > General
The table below provides a summary of the items displayed on the FAX
Restrictions > General page.
Transmit Restriction

Selects the transmitting restriction between Off and Use Permit List +
Address Book.

Receive Restriction
Selects the receiving restriction between Off, Use Permit List + Address
Book, and Use Reject List.

Unknown Number Reception
Displayed when Use Reject List is selected in Receive Restriction. This
determines the behavior when the machine has received a FAX with an
unknown FAX number. Select Permit to permit reception of unknown
numbered faxes and select Reject to reject unknown numbered faxes.

FAX / i-FAX > FAX > FAX Restrictions > Permit Number List
The section below provides a summary of the items displayed on the Permit
Number List page.
Add

Clicking Add will display the Permit Number List - Add page. Enter in
Permit FAX Number the FAX number to add, then click Submit.

Delete
To delete a FAX number from Permit Number List, click the check box next
to the FAX number, then click Delete. If you accept the confirming prompt,
click Delete.

FAX / i-FAX > FAX > FAX Restrictions > Permit ID List
The table below provides a summary of the items displayed on the Permit ID
List page.
Add

Clicking Add will display the Permit ID List - Add page. Enter in Permit
FAX ID the FAX ID to add, then click Submit.

Delete
To delete a FAX ID from Permit Number List, click the check box next to
the FAX ID, then click Delete. If you accept the confirming prompt, click
Delete.
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FAX / i-FAX > FAX > FAX Restrictions > Reject Number List
The section below provides a summary of the items displayed on the Reject
Number List page.
Add

Clicking Add will display the Reject Number List - Add page. Enter in
Reject FAX Number the FAX number to reject, then click Submit.

Delete
To delete a FAX number from Reject Number List, click the check box next
to the FAX ID, then click Delete. If you accept the confirming prompt, click
Delete.

FAX / i-FAX > FAX > Encryption Key
Specifies the encryption key in hexadecimal. The length of the encryption key is
16 digits. Enter 16 characters using the numbers 0-9 and the letters A-F.

FAX / i-FAX > i-FAX > Defaults
The section below provides a summary of the item displayed on the Defaults
page.
i-FAX

Enables or disables i-FAX. Set to On to enable.

FAX / i-FAX > i-FAX > SMTP
The section below provides a summary of the items displayed on the SMTP
page.
SMTP Port Number

Set the SMTP Port Number or use the SMTP default port 25.
SMTP Server Name

Enter the SMTP server name or its IP address. If entering the name, rather
than the IP address, a DNS server address must also be configured. The
DNS server address may be entered on the TCP/IP General page (Refer to
Advanced > Protocols > TCP/IP > General on page 6-32).

SMTP Server Timeout
Sets the timeout in seconds during which this machine tries to connect to the
SMTP server.

Authentication Protocol
Enables or disables the SMTP authentication protocol or sets POP before
SMTP as the protocol.

Authenticate as
Selects the user to be authenticated in SMTP authentication. If you want to
select a user other than i-FAX users, select Other and enter the Login User
Name and Login Password for authentication.

Login User Name
When Other is selected for Authenticate as, the account name set here will
be used for SMTP authentication.

Login Password
Enter the login password.
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POP before SMTP Timeout
Enter the timeout in seconds during which this machine tries to connect to
the SMTP server when set POP before SMTP as the Authentication
Protocol.

Test
Tests to confirm that the settings on this page are correct. When the Test
button is pressed, this machine tries to connect to the SMTP server.

E-mail Size Limit
Enter the maximum size of E-mail that can be sent in Kilobytes. When the
value is 0, the limitation for E-mail size is disabled.

Sender Address
Displays the sender address used for E-mails sent from this machine. For
how to change the sender address, set the Email address in E-mail
Address on FAX / i-FAX > i-FAX > POP3 on page 6-30.

Signature
Displays the signature to be inserted in the end of the E-mail body. For how
to change the signature, refer to Advanced > E-mail > SMTP > General on
page 6-38.

FAX / i-FAX > i-FAX > POP3
The section below provides a summary of the items displayed on the POP3
page.
Check Interval

Displays the interval, in minutes, for connecting to the POP3 server to check
for incoming e-mails at specific interval. Specify the interval in the range from
3 minutes to 60 minutes. The default is 15 minutes.

Run once now
Click the Receive button to immediately receive E-mail from the POP3
server.

E-mail Address
Enter the E-mail address for i-FAX. The E-mail address is displayed in
Sender Address on FAX / i-FAX > i-FAX > SMTP on page 6-29.

POP3 Server Name
Enter the POP3 server name or IP address.

POP3 Port Number
Enter the POP3 port number or use the default port number 110.

POP3 Server Timeout
Enter the timeout in seconds during which this machine tries to connect to
the POP3 server.

Login User Name
Enter the login name of the user.

Login Password
Enter the password for connecting to the user name above.

Use APOP
Enables (On) or disables (Off) APOP.

Test
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Tests to confirm that the settings on this page are correct. When the Test
button is pressed, this machine tries to connect to the POP3 server.

E-mail Size Limit
Enter maximum E-mail size in Kilobytes. When the value is 0, the limitation
for E-mail size is disabled.

Cover Page
Specifies whether to print the body of E-mail in addition to the attached files.
When this item is set to On, the attached files and the body of E-mail are
printed.
When no attached files exist, only the body of E-mail is printed. When this
item is set to Off, only the attached files are printed. When no attached files
exist, nothing is printed.

FAX / i-FAX > i-FAX > Domain Restrictions > General
The section below provides a summary of the items displayed on the Domain
Restrictions page.
SMTP Restriction

Selects the restriction level from Off, Reject, and Permit.
POP3 Restriction

Selects the restriction level from Off, Reject, and Permit.

FAX / i-FAX > i-FAX > Domain Restrictions > SMTP Restriction
List

The section below provides a summary of the items displayed on the SMTP
Restriction List page.
Domain Name

Enter the domain names that can be permitted or rejected. You can also
specify the E-mail addresses.

FAX / i-FAX > i-FAX > Domain Restrictions > POP3 Restriction
List

The section below provides a summary of the items displayed on the POP3
Restriction List page.
Domain Name

Enter the domain names that can be permitted or rejected. You can also
specify the E-mail addresses.

Advanced Page
This section includes advanced settings that apply to the machine and is
comprised primarily of advanced network settings.
Always restart network or this machine after you have completed these settings
in order to properly register the content of those settings in the machine. Refer
to Basic > Defaults > Reset on page 6-6.
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Advanced > Network Protocol Quick Summary/Secure Protocol
Quick Summary

A quick summary of the protocols that appear in the Advanced page are as
follows:

• TCP/IP
• NetWare
• IPP
• AppleTalk
• NetBEUI
• SMTP
• POP3
• SNMP v1/v2c
• SNMP v3
• SSL
• IPSec
• IEEE802.1x

Advanced > Protocols > TCP/IP > General
The section below provides a summary of the items displayed on the TCP/IP >
General page.
Host Name

Specifies a name for the printing system network component. This name is
also used as the NetBEUI printer name and WSD device name.

IPv4 Settings

• DHCP/BOOTP
Specifies whether or not to automatically obtain an IP address using DHCP or
BOOTP.

• Auto-IP
Turn On to automatically assign a unique IP address even though a DHCP
server does not exist or DHCP setting is Off in the printing system. The range
of the IP address to be assigned is from 169.254.0.0 to 169.254.255.255,
which is reserved for Auto-IP. If an IP address is already assigned by a
DHCP server, this does not resolve a new IP address.

• IP Address
If DHCP = OFF, then a static IPv4 address can be entered in this field as part
of the system network settings. If DHCP = ON, then a dynamic IPv4 address
is assigned to the device, and the field is grayed out. The format of the IPv4
address is a sequence of numbers separated by dots. For
example: 192.168.110.171

• Subnet Mask
Specifies the subnet mask.

• Default Gateway
Specifies the IP address of the default gateway.

• Domain Name
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Specifies the DNS (Domain Name System) name of the domain to which the
printing system belongs. It should not contain the host printer name, for
example, "abcde.com".

• DNS Server (Primary, Secondary)
Specifies the IP addresses of the primary and secondary DNS (Domain
Name System) servers. When DHCP/BOOTP is turned On, you can select to
use the DNS server obtained via DHCP, or you can enter static DNS server
information in the Primary and Secondary fields provided.

• WINS Server (Primary, Secondary)
Specifies the IP addresses of the primary and secondary WINS (Windows
Internet Name Service) servers. When DHCP/BOOTP is turned On, you can
select to use the WINS server obtained via DHCP, or you can enter static
WINS server information in the Primary and Secondary fields provided.

• Bonjour
This section enables/disable Bonjour Protocol.
You can add a Bonjour-enabled printer in Mac OS X using the Printer Setup
Utility. The procedure varies slightly between Mac OS X versions. Bonjour
print is also available in Windows OS using "Bonjour Print Services for
Windows". With this tool installed on the Windows PC, a Bonjour-enabled
printer can be installed using the "Bonjour Printer Wizard."
To allow printing from the Mac OS X system, the printer needs to support
KPDL.

• Bonjour Name
If Bonjour is turned On, this specifies the Bonjour name to be used.

IPv6 Settings

• IPv6
Specifies whether or not to enable the IPv6 protocol. Select On to use the
IPv6 protocol.

• IP Address
A static IPv6 address can be entered in this field for the device as part of the
system network settings. The format of the IPv6 address is a sequence of
numbers separated by colons, e.g. 2001:db8:3c4d:15::1a2c:1a1f.

• Prefix Length
Specifies the IPv6 prefix length. It can be a decimal value between 0 and 128.

• RA (Stateless)
Select On to use RA instead of the DHCP server to configure IPv6
addresses. This function will require the presence of an RA Stateless router
in the network that the device is connected to.

• Default Gateway
Specifies the IPv6 address of the default gateway.

• DHCPv6 (Stateful)
Specifies whether or not to obtain IPv6 IP addresses by automatic
configuration. When RA is turned On, the IP addresses and server
information are obtained via DHCPv6 based on the settings of the automatic
configuration made under RA (router setting). This function requires the
presence of a DHCPv6 router in the network that the device is connected to.

• Domain Name
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Specifies the domain name of the domain to which the printing system
belongs.

• DNS Servers (Primary, Secondary)
Specifies the IP addresses of the primary and secondary DNS (Domain
Name System) servers. When DHCPv6 (Stateful) is turned On, you can
select to use the DNS server obtained via DHCP, or you can enter static DNS
server information in the Primary and Secondary fields provided.

Advanced > Protocols > TCP/IP > IP Filters
This page allows you to configure IP filters. IP filters restrict access to the
printing system based on the IP addresses and protocols.
Specify the IP addresses or network addresses of the hosts to which access is
granted.
If nothing is specified on this page, access from all hosts is allowed.
IP Filter (IPv4)

• IP Address (IPv4)
Specifies the IP address or network address to be permitted.
Subnet Mask
Specifies the subnet mask to be permitted. When there are no entries,
access is allowed to all.
To allow access to a network, enter the network IPv4 address, and the
subnet mask. For example: To allow access from all hosts on network 192,
enter "192.0.0.0" for the IP address, and "255.0.0.0" for the subnet
mask. Subnet mask can also be left blank.
To allow access to a single IP address, enter the IPv4 address, and
"255.255.255.255" for the subnet mask.

• Protocols
Specifies the protocol to be permitted. The following protocols can be
selected:

• LPD
• FTP
• IPP
• ThinPrint
• HTTP
• Raw
• SNMP
• IPP over SSL
• HTTPS

IP Filters (IPv6)

• IP Address (IPv6)
Specifies the IP addresses to which access is granted. When there are no
entries, access is allowed to all. The number of addresses that can be
specified depends on the IPv6 network address along with the prefix length
setting. To filter a single IPv6 address: Enter the desired IPv6 address, along
with a prefix length of 128.

• Prefix Length
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Specifies the IPv6 prefix length. It can be a decimal value between 0 and 128.
• Protocols

Specifies the protocols through which access is granted. The following
protocols can be selected.

• LPD
• FTP
• IPP
• ThinPrint
• HTTP
• Raw
• SNMP
• IPP over SSL
• HTTPS

Advanced > Protocols > TCP/IP > Logical Printers
This page allows you to configure the Logical Printers. This machine can be
used as a virtual printer for converting ASCII print data to PostScript data or for
adding and/or replacing a character strings (commands) at the beginning or end
of job data. Up to four logical printers can be set.
Each logical printer can be used with either following print protocols: FTP, LPR,
IPP, IPPS, SMB (NetBEUI), or RAW. If no port is specified during print, the
default port used will be Logical Printer 1 (LP1), port 9100.
TCP/IP Port Number

Specifies the port number for the logical printer as well as the TCP raw port
number (9100, etc.). Conversion is applied to data that is input to the
specified raw port in accordance with the selected logical printer. This port is
invalid if it is given a port number that is the same as that of an already
specified port (For example, FTP or LPD).

Bi-directional Printing
Bi-directional Printing can be set to On or Off when printing to the TCP/IP
RAW port. When Bi-directional Printing = Off, all send data is discarded. In
order to have the data that is received from the printer returned to the client
when printing with PostScript, PJL and other such commands, it is
necessary to set Bi-directional Printing = On.

Start of Job String
Specifies the character string sent to the printer before output, directly to the
output port (lp port). This character string is used when it is necessary to
transmit a control code before the print data is sent.

End of Job String
Specifies the character string sent to the printer after output, directly to the
output port (lp port). This character string is used when it is necessary to
transmit a control code after the print data is sent.

Advanced > Protocols > NetWare
This printing system supports both NDS and bindery printing in either print
server mode or remote printer mode.
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NetWare setup requires installation of the following client software and login
with Administrator Privileges. If you are unsure, please contact your network
administrator.
With Novell Client, creation of the NetWare print objects with the AdminManager
NetWare Setup Wizard requires the NetWare Client from Novell. For NetWare
printing, you may use the NetWare Client from either Novell or Microsoft.
For Admin Privileges, network operations (creating queues etc.) require 'admin'
or 'supervisor' privileges (or equivalent). Certain portions of AdminManager may
be inoperable if you attempt those operations without sufficient privileges.
NetWare Protocol

Enables or disables the Network Protocol.
Bindery Mode

Enables or disables Bindery Mode.
Frame Type

Sets the Frame type. You can choose from Auto, 802.3, Ethernet-II, SNAP or
802.2.

File Server (Primary)
Enter the name of the primary File Server.

NDS Tree
Enter the name of the NDS Tree.

NDS Context
Enter the NDS Context.

Printer Server Mode
Enables or disables Print Server Mode.

Print Server Name
Enter the Print Server Name.

Queue Polling Interval
Enter the Queue Polling Interval in seconds.

Password (optional)
Enter the Password, if required. Login to NetWare will be successful only the
password set here matches the Printer Server password set within the
NetWare utilities.

Remote Print Mode
Enables or disable Remote Print Mode.

Print Server Name
Enter the name of the printer server that the remote printer belongs to.

Job Timeout
Enter the timeout in seconds.

Advanced > Protocols > IPP
Using IPP (Internet Printing Protocol) or IPP over SSL, you can print to the
device over the Internet, or an intranet.
IPP

Enables or disables IPP.

Embedded Web Server RX 6-36



Settings Pages

IPP Port Number
Sets the port number to be used by IPP. In normal situations, set this port
number to 631, e.g. http://(IP address):631/printers/lp1

IPP over SSL
Enables or disables the IPP over SSL protocol. When IPPS is set to On, SSL
in the Secure Protocol Settings must also be set to On. For details on secure
protocol, see Advanced > Security > Secure Protocols on page 6-48.

IPP over SSL Port Number
Sets the port number to be used by IPP over SSL. In normal situations, set
this port number to 443, e.g. https://(IP address):443/printers/lp1

Advanced > Protocols > ThinPrint
Enabling ThinPrint allows the reception and decompression of compressed print
jobs using the ThinPrint technology within a network. For the implementation,
the system uses a ThinPrint port. The default port is port 4000.
ThinPrint

Enables or disables the ThinPrint protocol.
ThinPrint Port Number

Set the ThinPrint Port Number or use the default port 4000.
ThinPrint over SSL

Enables or disables the ThinPrint over SSL protocol. When SSL is set to On,
SSL in the Secure Protocol Settings page must also be set to On. For details
on secure protocol, see Advanced > Security > Secure Protocols on page 6-
48.

Advanced > Protocols > AppleTalk
You can print from Macintosh computers using the AppleTalk protocol.
Appletalk protocol is available in OS 10 versions 10.5 and below. Appletalk is no
longer supported in Mac OS version 10.6.
The printing system network component supports Mac OS of various versions
(Web Browser on page 1-1) and is compatible with LaserWriter driver version
8.x.
To set up the Ethernet interface to communicate via AppleTalk, enables
AppleTalk protocol operation on the printing system.
AppleTalk

Enables or disables AppleTalk protocol.
Printer Name

Specifies the name of the printing system in the AppleTalk network.
Zone Name

Specifies the name of the AppleTalk zone (network). An asterisk (*) means
the default zone.

Advanced > Protocols > NetBEUI
Peer-to-peer printing (SMB Print) is available using NetBEUI protocol. With this
method, the printing system is located in Windows Network Neighborhood.
NetBEUI is an enhanced version of the NetBIOS protocol, which is used for
transport of SMB protocol.
NetBEUI Protocol
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Enables or disables NetBEUI protocol. If NetBEUI is turned On, name
resolution via NetBIOS (NMB) can be used.

Printer Name
Printer Name correlates with Host Name in the TCP/IP General page (Refer
to Advanced > Protocols > TCP/IP > General on page 6-32). If you want to
change the NetBEUI printer name, change the TCP/IP Host Name.

Workgroup
Workgroup represents the workgroup which will appear in Entire Network in
"Windows Network Neighborhood."

Comment
You can enter comments here. (This can also be left blank.)

Advanced > E-mail > SMTP > General
Device event reports and counter status such as Low Toner and other
information can be sent automatically via E-mail to the specified E-mail address.
To use the mail function, configure SMTP (Simple Mail Transfer Protocol) to
connect this device to an E-mail server.
SMTP

Enables or disables SMTP protocol. To use E-mail, this protocol must be
enabled.

SMTP Port Number
Set the SMTP Port Number, or use the SMTP default port 25. Choose the
default port number 465 for SMTP connections over SSL.

SMTP Server Name
Enter the SMTP server host name or its IP address. If entering the host
name, rather than the IP address, a DNS server address must also be
configured. The DNS server address may be entered on the TCP/IP General
page (refer to Advanced > Protocols > TCP/IP > General on page 6-32).

SMTP Server Timeout
Sets the timeout in seconds during which this device tries to connect to the
SMTP server.

Authentication Protocol
Enables or disables the SMTP authentication protocol or sets POP before
SMTP as the authentication type.

Authenticate as
Specifies the user to be authenticated in SMTP authentication. When POP3
User 1 to 3 (Refer to Advanced > E-mail > POP3 > User # on page 6-40) and
i-FAX User are set, you can select one of them. If you want to select a
different user, select Other and enter the login account name and login
password for authentication.

Login User Name
When Other is selected for Authenticate as, the account name set here will
be used for SMTP authentication.

Login Password
When Other is selected for Authenticate as, the password set here will be
used for authentication.

SMTP Security
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Enables or disables the SMTP Security. When this protocol is enabled,
either SSL/TLS or STARTTLS must be selected. To enable SMTP security,
the SMTP port may have to be changed according to the server settings.
Typically, 465 for SSL/TLS and 25 or 587 for STARTTLS are well-known
SMTP ports.

POP before SMTP Timeout
Enter the timeout in seconds during which this machine tries to connect to
the SMTP server when set POP before SMTP as the Authentication
Protocol.

Test
Tests to confirm that the settings on this page are correct. When the Test
button is pressed, this machine tries to connect to the SMTP server.

E-mail Size Limit
Enter the maximum size of E-mail that can be sent in Kilobytes. When the
value is 0, the limitation for E-mail size is disabled.

Sender Address
Enter the E-mail address of the person responsible for the printing system,
such as the printer administrator. A reply or non-delivery report will go to a
person rather than to the machine. The sender address must be entered
correctly for SMTP authentication. Note that no mail message can be sent
unless the sender's address is specified.

Signature
Enter the signature. The signature is free form text that will appear at the end
of the E-mail body. It is often used for further identification of the machine.

Domain Restriction
Enter the domain names that can be permitted or rejected. You can also
specify the E-mail addresses.

Advanced > E-mail > SMTP > E-mail Recipient #
This page allows you to set the address for receiving E-mail and contents of
event reports. Up to three recipients can be set.
Recipient # Address

Enter the E-mail address for this recipient. Entering a group address allows
to simultaneously send reports to the recipients.

Subject
Specifies the information to be displayed at Subject. When the following
variable starting with "%" is entered, it is converted to values for information
set on this machine and displayed in the subject line.

• %printer = Model
• %serial = Serial Number
• %etheraddr = MAC Address
• %host = Host Name
• %ip = IP Address

Event Report Items
Select the events you want to be reported. These events are:

• Add Paper
• Low Toner
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• Add Toner
• Cover Open
• Paper Jam
• All Other Errors

Event Report Interval
Enter the E-mail interval. An E-mail will be sent at the end of the interval only
when at least one of the selected error conditions has occurred during the
interval. The interval can be set from 1 minute to 10000 minutes.

Scheduled Report Items
Check one or more items from Printer Status, Network Status, and
Counter Status.

Scheduled Report Interval
Select the time or interval for sending the status information.

• None: No report is sent.
• Monthly: Sends on the specified time of specified month.
• Weekly: Sends on the specified time of every week.
• Daily: Sends at the specified time of every day.
• Hourly: Sends at the specified interval every hour.

If a specified day does not exist in the month, such as the 31st, the last day
of the month is used as the specified day.

Run once now
You can test this by clicking the Send button to immediately send a report.

Advanced > E-mail > POP3 > General
To use the E-mail function, you need to connect the printing system to an E-mail
server using the POP3 protocol.
POP3 Protocol

Enables or disables POP3 protocol.
Check Interval

Checks E-mails in POP3 server at specific interval. Specify the interval in the
range from 3 minutes to 60 minutes. The default is 15 minutes.

Run once now
Click the Receive button to immediately receive E-mail from the POP3
server.

Domain Restriction
Enter the domain names that can be permitted or rejected. You can also
specify the E-mail addresses.

Advanced > E-mail > POP3 > User #
This page allows you to set the POP3 user account and information on the
POP3 server. Up to three users can be set.
User Profile #

Enables or disables this user number.
E-mail Address
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Enter the E-mail address.
POP3 Server Name

Enter the POP3 server name or IP address. If you use the host name, you
must first specify the DNS server information. For details, refer to Advanced
> Protocols > TCP/IP > General on page 6-32.

POP3 Port Number
Set the POP3 Port Number, or use the POP3 default port number 110.
Choose the default port number 995 for POP3 connections over SSL.

POP3 Server Timeout
Enter the timeout in seconds during which this machine tries to connect to
the POP3 server.

Login User Name
Enter the login name of the user.

Login Password
Enter the password for connecting to the user name above.

Use APOP
Enables or disables APOP. APOP is an encryption mechanism used for
encrypting the Login Password during communication with the POP3 server.
When APOP = Off, the Login Password is sent using plain ASCII text. When
APOP = On, the Login Password is encrypted, and cannot be read. APOP
requires that the POP3 server supports APOP, and has APOP enabled.

POP3 Security
Enables or disables POP3 Security. When this protocol is enabled, either
SSL/TLS or STARTTLS must be selected. To enable POP3 security, the
POP3 port may have to be changed according to the server settings.
Typically, 465 for SSL/TLS and 25 or 587 for STARTTLS are well-known
SMTP ports.

Test
This will test one transmission for each press, attempting to establish
communication with the POP3 server.

Delete e-mail after retrieval
Enables or disables the Delete E-mail after retrieval function. When this item
is set to On, the retrieved E-mail is deleted from the POP3 server. When this
item is set to Off, the E-mail will not be deleted after retrieved from the POP3
server.

E-mail size limit
Enter maximum E-mail size in Kilobytes. When the value is 0, the limitation
for E-mail size is disabled.

Cover Page
Specifies whether to print the body of E-mail in addition to the attached files.
When this item is set to On, the attached files and the body of E-mail are
printed. When no attached files exist, only the body of E-mail is printed.
When this item is set to Off, only the attached files are printed. When no
attached files exist, nothing is printed.

Advanced > Management > SNMP > SNMPv1/v2c
The SNMP protocol is used for providing and transferring management
information within the network environment. Should an error occur such as Add
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Paper, the printing system automatically generates a trap, an error message
sent to predetermined trap recipients.
The community names are used like passwords.
SNMPv1/v2c

Sets whether to use the SNMPv1/v2c protocol. Set On to use it. After you
have changed the setting, you must restart the printing system.

Read Community
Enter the community name for SNMP requests to read a value. The default
name is 'public'. After you have changed the setting, you must restart the
printing system.

Write Community
Enter the community name for SNMP requests to write (change) a value.
The default name is 'public'. After you have changed the setting, you must
restart the printing system.

sysContact
The MIB-II sysContact object. Usually this is the E-mail address of the
network administrator.

sysName
The MIB-II sysName object. Usually this is the host or domain name of the
printing system.

sysLocation
The MIB-II sysLocation object. Usually this is the location information of the
printing system which is described under Device Defaults. To change
location, go to Location in Basic > Defaults > Device Defaults.

HP Web Jetadmin Compatibility
Turns HP Web Jetadmin Compatibility On or Off. After you have changed
the setting, you must restart the printing system.

Authentication Traps
Specifies whether to use authentication traps. If enabled (On), an SNMP trap
is generated when an attempt to read or write is made using an incorrect
community name. The trap is sent to the configured trap address. After you
have changed the setting, you must restart the printing system.

Trap Community
The SNMP trap community name to be used when the printing system
generates a trap.

Trap IP Address (IPv4)
Enter the IPv4 address that receives traps. Select On to enable trap
receiving.

Trap IP Address (IPv6)
Enter the IPv6 address that receives traps. Select On to enable trap
receiving.

Trap IPX Address
Enter the IPX address that receives traps. Select On to enable trap
receiving.

Selected Errors
Select the events which will cause a trap to be generated from Add Paper,
Low Toner, Add Toner, Cover Open, Paper Jam, and All Other Errors.

Embedded Web Server RX 6-42



Settings Pages

Advanced > Management > SNMP > SNMPv3
The section below provides a summary of the items displayed on the SNMPv3
page. After you have changed the setting, you must restart the printing system.
SNMPv3

Sets whether to use the SNMPv3 protocol. Set On to use it.
Authentication

Sets whether to authenticate the user in SNMP communication.
Hash

Selects the hash algorithm. This item is displayed when the Authentication
is On.

Privacy
Sets whether to encrypt the communicated data in SNMP communication.
This becomes available when Authentication is enabled.

Encryption
Selects the encryption algorithm. This item is displayed when Privacy is On.

User Name
Enter the name of the read-only user.

Password
Enter the password for the read-only user.

User Name
Enter the name of the read/write user.

Password
Enter the password the read/write user.

Advanced > Management > LDAP > General
The printing system can refer to the address book which is on the LDAP server
as an external address book and assign a FAX number and E-mail address to
the destination.
LDAP

Enables or disables access to the LDAP protocol.
LDAP Server Name

Specifies a name or IP address for the LDAP server.
LDAP Port Number

Specifies a port number for LDAP or use the LDAP default port 389.
Search Timeout

Specifies a period of time for searching the LDAP server.
Login User Name

Specifies the user name.
Login Password

Specifies the password.
Max Search Results
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Specifies a maximum number of displayed results which have been
searched on the LDAP address book. The actual number of results
displayed varies from model to model.

Search Base
Specifies a base object which indicates the starting point in the tree structure
of the database for the LDAP directory searching.

LDAP Security
Selects the type of encryption from the drop-down list, according to the type
of security employed by the LDAP server. Select Off when encryption is not
used.

• STARTTLS
Uses explicit mode for data communication. Select this if the server supports
the startTLS command. This uses the same port (389) as LDAP.

• SSL/TLS
Uses implicit mode for data communication. The server provides services
using the LDAP over SSL port (636). Encryption is applied to any data
communication using this port.

Authentication Type
Selects either the Simple or SASL for the authentication type.

Test
Tests to confirm that the settings on this page are correct. When the Test
button is pressed, this machine tries to connect to the LDAP server.

Advanced > Management > LDAP > Ext Address Book
The printing system can refer to the address book which is on the LDAP server
as an external address book and assign a FAX number and E-mail address to
the destination.
Display Mode

Selects the default display mode from Display from the first name and
Display from the family name.

Search Criteria

• Display Name

Enter the name of the address to search.

• LDAP Attribute

Enter the LDAP attribute of the address to search.
Return Value

• LDAP Attribute

Enter the LDAP attribute to return.

• Job Type

Select job type from E-mail, FAX, and i-FAX.
Optional Return Value

• Display Name

Enter the name of the optional fields.
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• LDAP Attribute

Enter the LDAP attribute of the optional fields.

Advanced > Management > Authentication > General
Setting Authentication allows only the predefined users to access pages. In
addition, you can discriminate users by giving either the General User or
Administrator privilege to each user. Before using the authentication function,
you have to define those users. For how to define users, refer to Basic >
Security > User Login on page 6-10.
Authenticate Mode
Specifies whether to enable or disable the authentication function. To disable it,
select Off. To enable it, select either of the following.

• Local Authentication
Users are registered in this machine and one-to-one authentication is
performed between this machine and a PC.

• Network Authentication
This machine and relevant PCs need to be under the management of the
Windows domain network. Depending on model, users registered in this
machine must be the same as those registered in the domain controller.

Host Name
Enter the host name of the Windows domain controllers when Network
Authentication is specified as Authenticate Mode.

Port Number
Use the numeric keypad to type the port number when Server Type below is
Ext(ernal).

Server Type
This specifies the authentication method used by the domain controller when
Network Authentication is enabled. Select NTLM when the domain
controller is Windows NT, Kerberos for Windows 2000 Server or Windows
Server 2003, or Ext(ernal).

Domain Name
When Network Authentication is enabled, enter up to 10 domain names.
You can select one of these domains at login. Select the Default radio
button to the left of a domain name which you want to make the default
domain.

Note: The default domain should be the one which belongs to the host
specified in Host Name.

Keyboard Login
This determines whether login authentication is allowed via the machine
operation panel or not, despite the IC card authentication is activated (using
the IC card authentication kit installed).

Advanced > Management > Authentication > Network User
Property

This allows to obtain user information at authenticating the user over the
network. The LDAP protocol must be enabled in order to obtain user
information.
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Obtain Network User Property
Turned On to obtain user information.

LDAP Server Name
Specifies a host name or IP address for the LDAP server.

LDAP Port Number
Specifies a port number for LDAP or use the LDAP default port 389.

Search Timeout
Specifies a period of time for searching the LDAP server.

LDAP Security
Selects the type of encryption according to the type of security employed by
the LDAP server. Select Off when encryption is not used.

Authentication Type
Selects either the Simple or SASL for the authentication type.

Name 1 (2)
Specifies the LDAP attribute to obtain a user name for display, from the
LDAP server. The default for Name 1 is displayName.

E-mail Address
Specifies the LDAP attribute to obtain an E-mail address from the LDAP
server. The default is mail.

Advanced > Management > Authentication > Group Authorization
Set.

Once the network authentication has been established, you can add a group to
specify the Group Information and items for Job Authorization Settings.
LDAP must be enabled in order to activate group authorization.
Up to 20 group accounts are registerable. By default, a group account (Other)
has been preset. This is used to process any group account which does not fall
within the registered groups.
Group Authorization

Turned On if you want to individually authorize or deauthorize the groups.
Number of Registered Groups

The number of the groups currently registered.

Adding a New Group

1 Click Group Authorization Set., open the Group Authorization Set. page.

2 Click Add and specify group information and Off or Reject Usage.

3 Click Submit.

Editing a Group

1 Click Group Authorization Set., open the Group Authorization Set page.

2 Click the desired Group ID or Group Name to edit the group and modify their
information.
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3 Click Submit.

Deleting a Group

1 Click Group Authorization Set., open the Group Authorization Set. page.

2 Check the desired group. When the check box on the left side of Group ID is
selected, all groups displayed on the page will be checked.

3 Click Delete. The Group Authorization Set.-Delete page appears. You can
confirm the groups to delete.

4 Click Delete when the desired groups are selected.

Advanced > Management > IC-Card Settings
This feature is available when an optional IC card reader is installed with the
printing system. This enables reading an IC card (FeliCa®) to login the printing
system.
IC Card Read Type

Selects either IDM or FeliCa® type for the IC card to use.
System Code, Service Code, Number of User Blocks to Use

These items are used when FeliCa is selected in IC Card Read Type. Each
item must be given a specific parameter for the FeliCa IC card to use.

Advanced > Management > Notification/Maintenance >
Maintenance Notification

This feature defines the recipient of maintenance information reports.
Equipment ID

This is the name by which the machine will be identified.
Recipient Address

The E-mail address of the recipient. If there is more than one recipient then
the addresses should be separated by a semicolon ";".

Subject
You can include model name, serial number, MAC address and equipment
ID in the subject line as follows: Enter one of the following conversion strings
starting with %. The string will be converted into a pre-defined string to
display the above information.

• %printer = Model
• %serial = Serial Number
• %etheraddr = MAC Address
• %equipid = Equipment ID

E-mail Interval
Sets the time or interval for sending the status information. Events will be
reported at the specified interval.

• None: No report is sent.
• Monthly: Sends on the specified time of specified month.
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• Weekly: Sends on the specified time of every week.
• Daily: Sends at the specified time of every day.
• Hourly: Sends at the specified interval every hour.

If a specified day does not exist in the month, such as the 31st, the last day
of the month is used as the specified day.

Run once now
You can test this by clicking the Send button to immediately send a report.

Advanced > Management > Maintenance Notification > Sending
Log History

This feature defines the Job Log Notification information reports.
Recipient Address

The E-mail address of the recipient. If there is more than one recipient then
the addresses should be separated by a semicolon ";".

Job Log Subject
You can include model name, serial number, and MAC address in the
subject line as follows: Enter one of the following conversion strings starting
with %. The string will be converted into a pre-defined string to display the
above information.

• %printer = Model
• %serial = Serial Number
• %etheraddr = MAC Address

SSFC Job Log Subject
Defines the Job Log Notification information reports only when you log in by
using a SSFC-format IC card. You can include the same information as
above. (This menu available when an optional IC-card reader is installed
with the printing system.)

Auto Sending
Determines whether the job log report is sent or not. Set this to On to send
the report.

Jobs
Set the number of job logs for sending, from 1 to 1500.

Run once now
You can test this by clicking the Send button to immediately send a report.

Advanced > Security > Secure Protocols
You can encrypt communication between a PC and this machine using SSL
encryption. For the changes made in the following to take effect, restart network
or this machine as described in Basic > Defaults > Reset on page 6-6.
SSL

Specifies whether or not to use the SSL protocol.
Serverside Settings

• Effective Encryption
Selects the encryption algorithm(s) to be used from DES, 3DES, and AES.

• HTTP Security
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Specifies the security level.

• Secure Only (HTTPS)
Encrypts all HTTP protocol communication. Access is possible only with a
URL that begins with "https://." Access attempts using an ordinary http://
URL are automatically redirected to the URL where "http://" is replaced
with "https://."

• Not Secure (HTTPS & HTTP)
Enables access for both encrypted and unencrypted HTTP protocol
communication. Access is possible with https:// and http:// URLs. The
former URL establishes encrypted communication and the latter
establishes normal communication.

IPP Security
Specifies the security level.

• Secure Only (IPPS)
Encrypts all IPP protocol communications.

• Not Secure (IPPS & IPP)
Enables access for both encrypted and unencrypted IPP protocol
communications.

Clientside Settings

• Effective Encryption
Selects the encryption algorithm(s) to be used from DES, 3DES, and AES.

• Certificate Verification
When set On, verify the expiration of the server certificate at communication.
If found expired, communication will fail. When set Off, the expiration will not
be verified.

Note: When the SSL is set to On and HTTP Security is set to Secure
(HTTPS), the document boxes cannot be accessed by the TWAIN driver.

Advanced > Security > IEEE802.1x
The IEEE802.1x security protocol allows the user to login to the secured
networks based on the client certificates.
IEEE802.1x

Specifies whether or not to use the IEEE802.1x protocol.
Authentication Type

Selects either EAP-TLS or PEAP (EAP-MS-CHAPv2) for the authentication
type.

Login User Name
Enter the name of the user who accesses the printing system. The
IEEE802.1x client certificate of this user must be valid.

Login Password
You can set a PEAP-based password. (This setting is valid when PEAP
[EAP-MS-CHAPv2] authentication type is selected.)

Common Name
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Specifies the common name of the server certificate if the server is required
to be authenticated. (This setting is valid when PEAP [EAP-MS-CHAPv2]
authentication type is selected.)

Match Rule of Common Name
When the server certificate is verified, the common name specified under
Common Name is compared with the common name on the server
certificate. This item allows you to specify whether the common names are
considered to be matched if they exactly or partially match. (This setting is
valid when PEAP [EAP-MS-CHAPv2] authentication type is selected.)

Expiration Verification
When this option is enabled, the expiration of the server certificate is verified
at communicating. If the server certificate is found expired, communication
will fail. When it is disabled, the expiration will not be verified.

Certificate Status
Displays whether the certificate is active or not.

Advanced > Security > IPSec > General
This section allows you to set access restrictions for IPSec protocol-based
communication.
IPSec

Specifies whether or not to enable the IPSec protocol. Select On to enable
the IPSec protocol. Select Off to disable it.

Restriction
Specifies the default policy for non-IPSec packets. Select Allow to allow
communication with all hosts and networks including those not permitted by
the rules described under Advanced > Security > IPSec > Rule1 (to Rule3)
on page 6-50. Select Deny to allow communication only with the hosts and
networks permitted by the rules.

Authentication Type
Specifies the authentication type used for IKE phase1. To set a character
string as the shared key and use it for communication, select Pre-shared
and enter the string of the pre-shared key in the text box. To use a CA-
issued device certificate or root certificate, select Certificates. When
Expiration Verification is enabled, the expiration of the server certificate is
verified at communicating. If the server certificate is found expired,
communication will fail. When it is disabled, the expiration will not be verified.
When you select Certificates, the contents of the CA certificate and root 1 to
3 certificates are displayed if they are enabled. When you click the CA or
Root button, you can view, import or delete CA-issued or root certificates.

Rule1 (to Rule3)
Shows whether the set rule is enabled or disabled. To enable or disable the
rule, refer to Advanced > Security > IPSec > Rule1 (to Rule3) on page 6-50.

Advanced > Security > IPSec > Rule1 (to Rule3)
These pages allow you to select or edit rules to use for IPSec protocol-based
communication.
Rule

Specifies whether or not to enable the selected IPSec policy rule. Select On
to enable the rule. Select Off to disable it.

Key Exchange (IKE phase1)
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When using IKE phase1, a secure connection with the other end is
established by generating ISAKMP SAs. Configure the following items so
that they meet the requirement of the other end.

• Mode
Main Mode protects identifications but requires more messages to be
exchanged with the other end. Aggressive Mode requires fewer messages
to be exchanged with the other end than Main Mode but restricts
identification protection and narrows the extent of the parameter negotiations.
When Aggressive Mode is selected and Preshared is selected for
Authentication Type, only host addresses can be specified for IP addresses
of the rule.

• Hash
Selects the hash algorithm.

• Encryption
Selects the encryption algorithm.

• Diffie-Hellman Group
The Diffie-Hellman key-sharing algorithm allows two hosts on an unsecured
network to share a private key securely. Select the Diffie-Hellman group to
use for key sharing.

• Lifetime (Time)
Specifies the lifetime of an ISAKMP SA in seconds.

Data Protection (IKE phase2)
In IKE phase2, IPSec SAs such as AH or ESP are established by using SAs
established in IKE phase1. Configure the following items so that they meet
the requirement of the other end.

• Protocol
Select ESP or AH for the protocol. ESP protects the privacy and integrity of
the packet contents. Select the hash algorithm and encryption algorithm
below. AH protects the integrity of the packet contents using encryption
checksum. Select the hash algorithm below.

• Hash
Selects the hash algorithm.

• Encryption
Selects the encryption algorithm. (When ESP is selected under Protocol.)

• PFS
When PFS is set to On (enabled), even if a key is decrypted, the decrypted
key cannot be used to decrypt the other keys generated after the decryption.
This improves the safety, but imposes a heavy burden because of more key-
generation processes.

• Diffie-Hellman Group
The Diffie-Hellman key-sharing algorithm allows two hosts on an unsecured
network to share a private key securely. Select the Diffie-Hellman group to
use for key sharing.

• Lifetime Measurement
Specifies whether the lifetime is measured by time or by time and data size.

• Lifetime (Time)/Lifetime (Data Size)
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Specifies the lifetime of an IPSec SA. Lifetime Measurement allows you to
select whether to use time or data size to specify the lifetime. When you
select Time & Data Size, an SA is disabled and updated when either the time
or data size of the SA exceeds the specified value.

• IP Version
Specifies the IP version of the other end. Select IPv4 or IPv6.

• IP Address (IPv4)
Specifies the IPv4 addresses of the hosts or network with which the print
system is connecting via IPSec. When you are restricting the scope of IPSec,
be sure to specify the IP addresses. If this field is blank, all IPv4 addresses
will be allowed to connect the print system.

• IP Address (IPv6)
Specifies the IPv6 addresses of the hosts or network with which the print
system is connecting via IPSec. When you are restricting the scope of IPSec,
be sure to specify the IP addresses. If this field is blank, all IPv6 addresses
will be allowed to connect the print system.

• Subnet Mask
When IPv4 is selected for IP Version, this specifies the subnet mask of the
hosts or network with which the print system is connecting via IPSec. If this
field is blank, the specified addresses are considered to be host addresses.

• Prefix Length
When IPv6 is selected for IP Version, this specifies the prefix length of the
hosts or network with which the print system is connecting via IPSec. If this
field is blank, the specified addresses are considered to be host addresses.

Advanced > Link > HyPAS Device Online
This page allows you to configure the environment to execute HyPAS
applications.
Application

Displays the number and status of HyPAS applications running in the
printing system. Clicking on the application's name or ID in Application List
shows details for the application.

Certificate
Allows to import, delete, or view Server Certificate and Client Certificate.

About
Displays the list of web browsers supported by the embedded server.

Embedded Web Server RX 6-52



7 Troubleshooting

Consult the table below to find basic solutions for problems you may encounter
with the embedded server.

Troubleshooting

Symptom Check Items Corrective Action Reference

I can't access the Is the power turned on to this Turn the power on to this Operation Guide
embedded server. machine? machine, wait until it is a

ready state, and try to access
the embedded server.

Is the network cable properly Connect the network cable Operation Guide
connected? properly.

Are the network settings that Perform the network settings -
are made in this machine from the operation panel.
correct? Contact your network

administrator for the
appropriate settings.

Is the IP address for this Enter the correct IP address. -
machine entered correctly? Check this machine IP

address with your network
administrator.

Are the LAN settings that are Check the settings made in -
made in Web browser Web browser. Refer to the
correct? Help function in your browser.

Has the administrator set up Access the embedded server Advanced >
an IP Filter function? from an approved IP address. Protocols > TCP/IP

> IP Filters on page
6-34

Is HTTP Security on the When HTTP Security is set to Advanced >
Advanced > Security > Secure (HTTPS), specify a Security > Secure
Secure Protocol page set to URL that begins with https://. Protocols on page
Secure (HTTPS)? You cannot access the 6-48

embedded server with an
http:// URL.

Does the version of your Use a browser application Web Browser on
browser application support that supports the embedded page 1-1
operation using the server.
embedded server?

Characters do not Does the version of your Use a browser application Web Browser on
display properly in browser application support that supports the embedded page 1-1
the embedded operation using the server.
server. embedded server?

— continued

7-1 User Guide



Troubleshooting

Is the same language as that Select the same language as Top Bar on page 2-
displayed on the operation that displayed on the 1
panel selected? operation panel.

I can't access the Has the administrator set a Enter the password. Basic > Security >
other pages. password? User Login on page

6-10

I can't perform Is the printer or scanner Wait until the operation has -
settings. currently in operation? been completed.

The settings I Did you click the Submit Click the Submit button and -
made are not button after making the move to another page or
registered. settings? close the embedded server

window.

Did you click the Restart Restart this machine. All Basic > Defaults >
button after making the settings will be registered. Reset on page 6-6
settings?

Are you using the System Operate the embedded server -
menu on this machine's panel after you have finished with
while the embedded server is the System menu.
being operated?

The administrator - Contact your dealer or service -
has forgotten the center.
Admin password.

Error or Warning is Is there an error message Perform the troubleshooting Operation Guide
displayed under the shown in the display? procedure the messages
STATUS indicator. suggests referring to the

Operation Guide.
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